## Contents

**Preface** ................................................................. v
Contacting Customer Support .......................................... v
Conventions used in this book .......................................... v
Publications ..................................................................... v
  Related publications .................................................. v

**Tivoli NetView for UNIX Version 7.1.3 Release Notes** ............ 1
New Features and Enhancements for Version 7.1.3 .................... 1
  Web Console Enhancements ........................................ 1
  Revised Tivoli Enterprise Console® Integration for Version 7.1.3 ..... 8
  Propagation of Unreachable Status ................................ 8
  New netmon Trace Option ........................................... 8

New Features and Enhancements for Version 7.1.2 .................... 9
  Enhanced Tivoli Enterprise Console Integration ................ 9
  Installation and Configuration Considerations ................ 9
  New instalnv Script Options ...................................... 9
  Using the nvits_config Script .................................... 10
  Using the tecits_upgrade Script to Upgrade to New Event Class Structure 11
Tivoli Enterprise Console Server Compatibility ................... 12
  New Variable Bindings for NetView Traps ....................... 12
  New NetView Traps .................................................. 13
  Web Console Security Enhancement .............................. 13
  Web Console Enhancements ........................................ 14
  Router Fault Isolation (RFI) Enhancements ..................... 16
  Status Update Request ............................................ 17
  nvmaputil Command Line Interface (CLI) Utility ................ 17
  Cisco Devices SmartSet .......................................... 18
  Updates to oid_to_type ......................................... 18
  SNMP Collections ................................................ 18
  Layer 2 Analysis Option Added to ovtopodump Utility .......... 18
  Java Runtime Environments ....................................... 18

Supported Platforms .................................................... 18
System Requirements .................................................... 18
  Upgrade Restriction ............................................. 18
  AIX Software Prerequisites .................................... 19
  Linux Hardware Prerequisites ................................ 19
  Linux Software Prerequisites ................................ 19
  Web Console System Requirements ............................... 19
Installation Notes ....................................................... 20
  Memory Prerequisite Checking .................................. 20
  Linux Installation Notes ....................................... 21
Deprecation Function ................................................... 21
Defects Fixed ................................................................ 21
Known Limitations ....................................................... 25
Documentation Changes ................................................ 27
Product Notes ............................................................ 33
Installing and Using the Tivoli NetView Language Kits ............. 36
  Supported Languages ............................................. 36
  Installation Requirements ....................................... 36
  Installing the Tivoli NetView Language Kits .................. 36
  LANG and LC_ALL Environment Variable Settings ............ 38
  Upgrading from a Previous Tivoli NetView Language Kit ... 39
  Migrating Security Files ......................................... 39

<table>
<thead>
<tr>
<th>Content</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>v</td>
</tr>
<tr>
<td>Contacting Customer Support</td>
<td>v</td>
</tr>
<tr>
<td>Conventions used in this book</td>
<td>v</td>
</tr>
<tr>
<td>Publications</td>
<td>v</td>
</tr>
<tr>
<td>Tivoli NetView for UNIX Version 7.1.3 Release Notes</td>
<td>1</td>
</tr>
<tr>
<td>New Features and Enhancements for Version 7.1.3</td>
<td>1</td>
</tr>
<tr>
<td>Web Console Enhancements</td>
<td>1</td>
</tr>
<tr>
<td>Revised Tivoli Enterprise Console® Integration for Version 7.1.3</td>
<td>8</td>
</tr>
<tr>
<td>Propagation of Unreachable Status</td>
<td>8</td>
</tr>
<tr>
<td>New netmon Trace Option</td>
<td>8</td>
</tr>
<tr>
<td>New Features and Enhancements for Version 7.1.2</td>
<td>9</td>
</tr>
<tr>
<td>Enhanced Tivoli Enterprise Console Integration</td>
<td>9</td>
</tr>
<tr>
<td>Installation and Configuration Considerations</td>
<td>9</td>
</tr>
<tr>
<td>New instalnv Script Options</td>
<td>9</td>
</tr>
<tr>
<td>Using the nvits_config Script</td>
<td>10</td>
</tr>
<tr>
<td>Using the tecits_upgrade Script to Upgrade to New Event Class Structure</td>
<td>11</td>
</tr>
<tr>
<td>Tivoli Enterprise Console Server Compatibility</td>
<td>12</td>
</tr>
<tr>
<td>New Variable Bindings for NetView Traps</td>
<td>12</td>
</tr>
<tr>
<td>New NetView Traps</td>
<td>13</td>
</tr>
<tr>
<td>Web Console Security Enhancement</td>
<td>13</td>
</tr>
<tr>
<td>Web Console Enhancements</td>
<td>14</td>
</tr>
<tr>
<td>Router Fault Isolation (RFI) Enhancements</td>
<td>16</td>
</tr>
<tr>
<td>Status Update Request</td>
<td>17</td>
</tr>
<tr>
<td>nvmaputil Command Line Interface (CLI) Utility</td>
<td>17</td>
</tr>
<tr>
<td>Cisco Devices SmartSet</td>
<td>18</td>
</tr>
<tr>
<td>Updates to oid_to_type</td>
<td>18</td>
</tr>
<tr>
<td>SNMP Collections</td>
<td>18</td>
</tr>
<tr>
<td>Layer 2 Analysis Option Added to ovtopodump Utility</td>
<td>18</td>
</tr>
<tr>
<td>Java Runtime Environments</td>
<td>18</td>
</tr>
<tr>
<td>Supported Platforms</td>
<td>18</td>
</tr>
<tr>
<td>System Requirements</td>
<td>18</td>
</tr>
<tr>
<td>Upgrade Restriction</td>
<td>18</td>
</tr>
<tr>
<td>AIX Software Prerequisites</td>
<td>19</td>
</tr>
<tr>
<td>Linux Hardware Prerequisites</td>
<td>19</td>
</tr>
<tr>
<td>Linux Software Prerequisites</td>
<td>19</td>
</tr>
<tr>
<td>Web Console System Requirements</td>
<td>19</td>
</tr>
<tr>
<td>Installation Notes</td>
<td>20</td>
</tr>
<tr>
<td>Memory Prerequisite Checking</td>
<td>20</td>
</tr>
<tr>
<td>Linux Installation Notes</td>
<td>21</td>
</tr>
<tr>
<td>Deprecation Function</td>
<td>21</td>
</tr>
<tr>
<td>Defects Fixed</td>
<td>21</td>
</tr>
<tr>
<td>Known Limitations</td>
<td>25</td>
</tr>
<tr>
<td>Documentation Changes</td>
<td>27</td>
</tr>
<tr>
<td>Product Notes</td>
<td>33</td>
</tr>
<tr>
<td>Installing and Using the Tivoli NetView Language Kits</td>
<td>36</td>
</tr>
<tr>
<td>Supported Languages</td>
<td>36</td>
</tr>
<tr>
<td>Installation Requirements</td>
<td>36</td>
</tr>
<tr>
<td>Installing the Tivoli NetView Language Kits</td>
<td>36</td>
</tr>
<tr>
<td>LANG and LC_ALL Environment Variable Settings</td>
<td>38</td>
</tr>
<tr>
<td>Upgrading from a Previous Tivoli NetView Language Kit</td>
<td>39</td>
</tr>
<tr>
<td>Migrating Security Files</td>
<td>39</td>
</tr>
</tbody>
</table>
Preface

This document provides information about the IBM® Tivoli® NetView® for UNIX®, Version 7.1.3 product. These notes provide the most current information and take precedence over all other documentation.

Review these notes thoroughly before installing, upgrading, or using this product.

Contacting Customer Support

If you have a problem with any Tivoli product, you can contact Customer Support. See the Tivoli Customer Support Handbook at the following Web site:

http://www.tivoli.com/support/handbook/

The handbook provides information about how to contact Customer Support, depending on the severity of your problem, and the following information:

- Registration and eligibility
- Telephone numbers and e-mail addresses, depending on the country in which you are located
- Information you must have before contacting Customer Support

Conventions used in this book

The following typeface conventions are used in this book:

**Bold**

- Lowercase and mixed-case commands, command options, and flags that appear within text appear like this, in **bold** type.
- Graphical user interface elements (except for titles of windows and dialogs) and names of keys also appear like this, in **bold** type.

*Italic*

- Variables, values you must provide, new terms, and words and phrases that are emphasized appear like this, in *italic* type.

Monospace

- Code examples, output, and message text appear like this, in monospace type.
- Text strings you must type, when they appear within text, names of Java™ methods and classes, and HTML and XML tags also appear like this, in monospace type.

Publications

See the Tivoli NetView Release Notes, Version 7.1 for information about installing the IBM Tivoli NetView for UNIX product.

Related publications

See the Tivoli NetView for UNIX library for more information about the IBM Tivoli NetView product.
This document provides important information about version 7.1.3 of the Tivoli NetView for UNIX program. These notes are the most current information for the product and take precedence over all other documentation.

This document, together with the Tivoli NetView Release Notes, Version 7.1 and the Tivoli NetView for UNIX Configuration Guide, Version 7.1, provides all of the necessary information for planning and performing the installation of the Tivoli NetView for UNIX, Version 7.1.3 program.

Note: Review these notes thoroughly before installing or using this product.

The version of Tivoli NetView described in this document is both a complete new installation and an upgrade installation for versions 7.1, 7.1.1, and 7.1.2 of the Tivoli NetView for UNIX program. All information contained in the Tivoli NetView Release Notes, Version 7.1 also applies to the Tivoli NetView for UNIX, Version 7.1.3 program unless otherwise noted in this document.

This document includes the following information:

- "New Features and Enhancements for Version 7.1.3" on page 9
- "New Features and Enhancements for Version 7.1.2" on page 9
- "Supported Platforms" on page 18
- "System Requirements" on page 18
- "Installation Notes" on page 20
- "Deprecated Function" on page 21
- "Defects Fixed" on page 21
- "Known Limitations" on page 25
- "Documentation Changes" on page 27
- "Product Notes" on page 33
- "Installing and Using the Tivoli NetView Language Kits" on page 36
- "Appendix A: Event Mapping and New Class Structure" on page 44
- "Appendix B: nvmaputil Utility" on page 48

New Features and Enhancements for Version 7.1.3

This section provides information about new features and enhancements for the Tivoli NetView, Version 7.1.3 product. See "New Features and Enhancements for Version 7.1.2" on page 9 for information about the Tivoli NetView, Version 7.1.2 product.

Web Console Enhancements

The following enhancements were made to the Web Console:

Customizing the Web Console Menu

The native NetView console has always supported customization of the menu structure using Application Registration Files (ARF). These ARF files enable you to add menu items to the menu bar. These menu items execute a program with context information such as the hostnames of the selected objects within the native map.

Similar menu item customizations can be made for the NetView Web Consoles. This section describes how to configure new menu items to be presented for particular roles. Each menu item that you define must be associated with a program.
to run when the item is selected. When the new menu item is selected, a URL
launch occurs. The URL launch causes the Web Server to invoke the program that
you have specified with appropriate context information. A web page displays the
program output. The output can be displayed either in HTML or plain text.

If the program output is specified to be HTML, the output of the program completely
defines what is displayed by the browser. If the program output is specified to be
plain text, the output of the program is displayed as a web page in which the
`stdout` command output lines are displayed using the default text color and the
`stderr` command output lines of the program are displayed as red text. To
customize the output, modify the following lines in file
/usr/OV/www/webapps/netview/ServerAppOutputToXHTML.xsl:
```
.stderr { color: red; }
.stdout { color: inherit; }
```

If you want to integrate command line utilities that print results in plain text, define
your menu item's action to use text-based results. If you want to create more
visually appealing custom programs, specify that your menu item action uses HTML
to display the results (for example, you might want to use HTML tables). Regardless
of which approach you take, you can use the OVw environment variables to provide
your Web Server-launched custom action with appropriate context information.

**Examples:** This section provides an example of the process you must follow to
add new menu items to the Web Console menu bar. (This example can also be
referenced from file: /usr/OV/prg_samples/webserver_examples/README.)

Use the following procedure to add the following two new menu items for all roles:

- **Object → Ovobjprint**
  Selecting this item displays the output of the following command for the object
  that is currently selected in Submap Explorer:
  ```bash
  ovobjprint -s <Selection_Name>
  ```

- **Object → MIB System Group**
  Selecting this item displays the MIB system information for the object that is
currently selected in Submap Explorer.

**Note:** The following example uses the MyActions.xml and MyMenuBar.xml sample
files that are provided with the Tivoli NetView product.

1. Copy file MyActions.xml into the NetView webserver directory structure:
   ```bash
   cp /usr/OV/prg_samples/webserver_examples/MyActions.xml
   /usr/OV/www/webapps/netview/warf/MyActions.xml
   ```

2. Either copy MyMenuBar.xml into the NetView webserver template directory
   with the command:
   ```bash
   cp /usr/OV/prg_samples/webserver_examples/MyMenuBar.xml
   /usr/OV/www/webapps/netview/warf/Templates/WebConsole/
   ```
   or edit file
   `/usr/OV/www/webapps/netview/warf/Templates/WebConsole/MenuBar.xml` and
   replace the following lines:
   ```xml
   <MenuItem name="managementpage">
     <ActionRef xlink:href='Actions.xml#xpointer(id("managementpage"))'/>
   </MenuItem>
   <Separator/>
   <MenuItem name="telnet"><ActionRef xlink:href='Actions.xml#xpointer(id("telnet"))'/></MenuItem>
   ```
with the following lines:

```xml
<MenuItem name="managementpage"><ActionRef xlink:href='Actions.xml#xpointer(id("managementpage"))'/></MenuItem>
<Separator/>
<MenuItem name="Ovobjprint"><ActionRef xlink:href='MyActions.xml#xpointer(id("launchOvobjprint"))'/></MenuItem>
<MenuItem name="MIB System"><ActionRef xlink:href='MyActions.xml#xpointer(id("launchMIBSystem"))'/></MenuItem>
<Separator/>
<MenuItem name="telnet"><ActionRef xlink:href='Actions.xml#xpointer(id("telnet"))'/></MenuItem>
```

**Note:** The default template files in the templates directory are replaced by new copies during migration. Any changes made to the MenuBar.xml file will be lost after migration. User defined template files will be preserved.

3. Use the Web Console Security application to add these two new actions to the roles that you want to contain them.

4. Select **File → Save**.

5. Select **File → Restart Web Server**.


7. Log on using an account configured for one of the roles that contains these new actions.

8. Select **File → Open** to start a new Submap Explorer.

9. Drill down into a segment.

10. Select a node and test the **Ovobjprint** and **MIB System** menu items that are displayed on the **Object** menu.

**Ovobjprint** launches a Web page that displays the command output and **MIB System** launches a Web page that displays the MIB query results for the MIB values found in the iso.org.dod.internet.mgmt.mib-2.system group.

**Note:** Ensure that you select nodes that have public community names, because the test application does not check for appropriate community names.

**Usage Notes:**

- Tags and attributes are fixed values and must be written in the correct order.
- The first element **Val** in the array element acts as a key:
  - The text represented by this Val must be unique among all ActionHandlers named LaunchServerAppHandler in all Actions XML files.
  - Only alphanumeric text can be used.
  - Spaces are not allowed.
- The second element in the array must specify the path and name of the executable program. Note that the full path must be specified.
- Any number of **Val** or **Var** tags can follow the second element to specify the arguments to be passed to your program. Var can be any of the following environment variables:
  - OVSelectionN (Where N is any value between 1 and 10, for example, OVwSelection1)
  - OVwSelections
  - OVwMenuItem
  - OVwNumSelections
Note: If OvwSelections is used, it must be the last argument in the array.

- Arguments containing spaces must be placed in a single Val tag. For example, specify Selection Name as: <Val>Selection Name</Val>.
- Arguments separated by spaces must be specified in separate Val tags. For example, specify
  <Val>nvsniffer</Val>
  <Val>-s</Val>
  <Val>-v</Val>
  <Val>-n</Val>

instead of
  <Val>nvsniffer -s -v -n</Val>

- To specify a value that contains any of the following characters separated by commas, you must wrap them in a CDATA section to avoid having them parsed as XML characters: >, <, &,, ', ''. See file MyActions.xml for examples.
- ActionHandler can have the attribute output set to HTML. This attribute indicates that the program output is already in HTML format and no formatting needs to be performed. If this attribute is not specified, the default is to wrap the program results with HTML tags, so that output from the stdout command is displayed in the default text color and output from the stderr command is displayed in red. Note that file MyActions.xml provides an example of both cases:
  - The output of the launchOvobjprint action is automatically HTML wrapped by applying the ServerAppToXHTML.xsl style sheet.
  - The output of the launchMIBSystem action is not wrapped, because it is assumed that this program generates HTML output.

Additional Information:
- The files in the /usr/OV/www/webappns/netview/warf directory are called web application registration files (WARF) and are similar to NetView application registration files (ARF). WARF files provide a NameField attribute that is similar to the NameField attribute defined in NetView ARFs. This attribute contains a comma-separated list of OvwDb name fields that are considered when performing a launch. For example, if you want to enable launching of your own ping command for nodes and interfaces, you can use the following AIX-based version:

```xml
<Action id="launchMyPing" securityConstraint="RelaxedAccess"
  roles="Administrator,Operator,SuperUser,User">
  <Name>My Ping</Name>
  <ShortDescription>My Ping</ShortDescription>
  <LongDescription>URL launch My Ping</LongDescription>
  <SelectionRule minSelected="1" nameField="IP Hostname,IP Address"
  expr="isNode OR isInterface" />
  <ActionHandler name="LaunchServerAppHandler">
    <Method>
      <MethodName>com.tivoli.netview.client.NetViewApplet.launchServerApp</MethodName>
    </Method>
    <ArgList>
      <Val>
        <Array>
          <Val>myping</Val>
          <Val>ping</Val>
          <Val>-c</Val>
          <Val>-v</Val>
        </Array>
        <Var>OVwSelection1</Var>
      </Val>
    </ArgList>
  </ActionHandler>
</Action>
```
Note that this action assigns a value to variable $OVwSelection1$ using the following criteria in the order listed:

1. If the object contains the IP Hostname field, then set variable $OVwSelection1$ to the value of this IP Hostname field.
2. If the object contains the IP Address field, then set variable $OVwSelection1$ to the value of this IP Address field.
3. Set variable $OVwSelection1$ to the object's Selection Name field value.

- The WARP expr attribute is similar to the ARF SelectionRule attribute. Each menu item in the Web Console can contain an expr to dynamically determine whether the menu item should be enabled. File /usr/OV/www/webapps/netview/warf/Actions.xml provides examples. If present, attribute expr automatically provides the diamond shape icon to the menu item to indicate that the menu item is context-sensitive for the objects currently selected in Submap Explorer.

- The roles attribute is used by the security console to list actions for particular roles. If you define a new action that contains a roles attribute, you do not have to go into each Role in the Security Console to explicitly add the action. Instead, start the Security Console and select File → Save and then File → Restart Web Server to add the new action to all the specified Roles.

**Debugging a Custom Menu Item:** This section provides information about writing debugging information to the /usr/OV/www/logs/netviewservlets.log file. Use the following process to help debug your custom menu item.

1. Stop the Web Server.
2. Edit file /usr/OV/www/classes/log4j.properties as follows:
   - Add the following statement to write the command that is issued by your custom menu item to the log:
     ```
     log4j.category.com.tivoli.netview.server.LaunchServerAppOutputGenerator=DEBUG
     ```
   For example, if you select Object → Ovobjprint for an object named winston, file /usr/OV/www/logs/netviewservlets.log would contain the following entry:
   ```
   cmd to run is '/usr/OV/bin/ovobjprint -s winston.us.corp.com'
   ```
   - Add the following lines to write the output of your custom menu item to the log:
     ```
     log4j.category.com.tivoli.netview.server.StdoutThread=DEBUG
     log4j.category.com.tivoli.netview.server.StderrThread=DEBUG
     ```
3. Restart the Web Server for the logging statements to take effect.
4. Use your custom menu item.
5. Review the information that was written to log /usr/OV/www/logs/netviewservlets.log.
6. When you are finished, either comment out or remove the lines that you have added to avoid filling the netviewservlets.log file.

**Enhanced Web Console Daemon Configuration**

The Web Console daemons can be configured using the Enable Web Daemons window of the Server Setup application. From Server Setup menu, select
Configure -> Configure Web Server -> Enable Web Daemons to display the Enable Web Daemons window. See Figure 1 for an example of the window.

Use this window to perform the following tasks:
- Enable the webserver daemon and configure its port.
- Enable the snmpserver daemon.
- Enable the netviewd daemon.

Note: SSL is not supported in the applet version of the Web Console from a Web browser.

Enhanced NetView Web Console Security using Secure Socket Layer
This section contains information about enabling and disabling SSL.

Enabling SSL: Use the following procedure to enable SSL:
1. Stop any Web Consoles that are running.
2. From the Server Setup menu select Configure -> Configure Web Server -> Enable Web Daemons. The following screen is displayed:

![Enable Web Daemons Window](Image)

Figure 1. Enable Web Daemons Window

3. Verify that yes is displayed on the Enable webserver daemon push button and that the correct port number is displayed. If no is displayed, select yes from the drop-down list.
4. Select yes from the Enable SSL for Secure Web Server Communications drop-down list.
5. Verify that you want to use the default port number that is specified. Specify a different port number if you do not want to use the default value.
6. Click either OK or Apply.
7. Stop and restart the Web Server daemon.
Note: After logging in to the Web Console using port 8080 with SSL enabled, https://server:8443 instead of http://server:8080 is displayed (where server is the name of the server).

Disabling SSL: Use the following procedure to disable SSL:
1. Stop any Web Consoles that are running.
2. From Server Setup select Configure → Configure Web Server → Enable Web Daemons.
3. Select no from the Enable SSL For Secure Web Server Communications drop-down list.
4. Click either OK or Apply.
5. Stop and restart the Web Server daemon.

Web Console Task Assistant
The Task Assistant provides task-specific online help for the Web Console.

The Task Assistant is started automatically when you start the Web Console. You can either detach the window, or close it. If you have closed the window, or if you are running from the applet, click Help → Open Task Assistant from the main menu bar to open the Task Assistant.

Use the Detach icon in the upper right corner of the Task Assistant panel to detach the panel from the Web Console window. Once detached, the Detach icon changes to a Reattach icon. Note that when you open a Web Console window, the Task Assistant will use the configuration (detached, attached, or closed) that was set in your last Web Console.

To use the Task Assistant, select either the Table of Contents or Index button from the Task Assistant toolbar. You can also access task-related help by selecting the question mark (?) icon available in the following windows:
- Submap Explorer
- Diagnostics
- Object Properties
- Event Browser
- Event Filter
- MIB Browser
- Server Status

Note: If the Web Console is accessed through an applet, the Task Assistant is displayed in an external browser window and Netscape Version 6 is required. For Windows, Internet Explorer Version 5.5 or higher can be also used.

Web Console MIB Browser Enhancements
The Web Console MIB Browser has been enhanced as follows:
- You can now request SNMP walks for MIB tables that cannot be displayed. If a table cannot be displayed in a table format, click Walk to display the information.
- The procedure that you use to graph MIB values displayed in a the table column has changed:
  1. Click Graph.
  2. Select the row from the list of MIBs that can be graphed.
  3. Click Graph. The Graph window is displayed.
  4. All MIB values are graphed by default. If you want to choose which MIB values are graphed, click Filter and select the MIB values that you want to graph.
5. Click Start to begin graphing.

**Revised Tivoli Enterprise Console® Integration for Version 7.1.3**

Enhanced integration between Tivoli NetView and IBM Tivoli Enterprise Console was introduced in Tivoli NetView for UNIX, Version 7.1.2 (with Tivoli Enterprise Console 3.7.1 fix pack 02). An updated version of the Tivoli Enterprise Console netview.rls rule set (the rule set which provides special event correlation for NetView TEC_ITS events) was included with Tivoli NetView for UNIX, Version 7.1.2. This rule set file is not included with Version 7.1.3, because it is included with Tivoli Enterprise Console 3.8, and it is active by default.

**Note:** If you are upgrading from Tivoli NetView for UNIX, Version 7.1.2 and you have already upgraded and configured the Tivoli Enterprise Console files, you do not need to perform any additional tasks when you upgrade to version 7.1.3.

For more information about the enhanced integration:
- See “Enhanced Tivoli Enterprise Console Integration” on page 9 in the “New Features and Enhancements for Version 7.1.2” section below.

**Propagation of Unreachable Status**

The propagation of Unreachable status has been changed. Previously, child objects with Unreachable status were ignored when determining the status of a parent object unless the status of all objects on a submap were Unreachable. The algorithm for determining marginal status has been changed so that if at least one child object has normal status and the status of at least one other child object is either Down, Marginal, or Unreachable the parent object’s status is Marginal.

For example, if a location submap contains two objects with Normal status and one object with Unreachable status, the status of the parent location object will now be Marginal, instead of Normal.

Note that the algorithm for determining Unreachable status is unchanged; that is, all child objects must be Unreachable for a parent object’s status to be Unreachable.

**New netmon Trace Option**

The netmon daemon now deletes the netmon.trace.old file (if one exists) before attempting to rename the full netmon.trace file to the same name. By default, the number of entries allowed in netmon.trace before the file wraps to netmon.trace.old is 100,000. A new option, \(-e MAXCOUNT\), enables you to change the number of entries that are written to the netmon.trace file before it wraps.

For example, the following procedure changes the wrap count to 200,000:
1. Edit file netmon.lrf.
2. Add the following option: \(-e 200000\)
3. Issue the following commands:
   - `ovstop netmon`
   - `ovaddobj /usr/OV/lrf/netmon.lrf`
New Features and Enhancements for Version 7.1.2

This section provides information about new features and enhancements for Tivoli NetView for UNIX, Version 7.1.2. All information in this section is also applicable to Tivoli NetView for UNIX, Version 7.1.3. See “New Features and Enhancements for Version 7.1.3” on page 1 for more information.

Enhanced Tivoli Enterprise Console Integration

The integration between Tivoli NetView and the Tivoli Enterprise Console has been enhanced to provide automatic event correlation for a default set of finely-tuned network events. This substantially improves the ability of event console operators to find the root cause of network-related problems, and provides automatic housekeeping by clearing obsolete network status events.

The Tivoli NetView program provides a default set of significant events that are forwarded to the Tivoli Enterprise Console including status events, selected SNMP data collection threshold events, and Router Fault Isolation events. See Table 8 on page 44 for the complete list of events that are forwarded by default.

The event class structure has been modified, including some slot mappings, for Tivoli NetView events that are sent to the Tivoli Enterprise Console. All classes in the new event class structure begin with the prefix TEC_ITS instead of OV. See Table 9 on page 45 for mapping of Tivoli NetView events to the new TEC_ITS classes that are not forwarded by default.

Note: Customers that upgrade from a previous version of Tivoli NetView can continue to use the old OV class structure to preserve their custom rules. However, you will not be able to use the enhanced integration capabilities provided by the new event class structure and rules. Customers can choose to upgrade at any time after an upgrade installation using the tecits_upgrade script described below.

Installation and Configuration Considerations

The following scripts enable you to easily configure integration with the Tivoli Enterprise Console server during or after installing Tivoli NetView.

1. The new options to the instalnv script enable you to configure event forwarding to a Tivoli Enterprise Console server during the installation.
2. Run the nvits_config script to configure event forwarding to a Tivoli Enterprise Console server after a new installation using the Tivoli Framework.
3. The tecits_upgrade script enables you to upgrade to the new TEC_ITS event class structure at any time after a Tivoli NetView upgrade installation.

New instalnv Script Options

During a new installation of Tivoli NetView for UNIX, Version 7.1.2, you have the option of configuring events to be forwarded to a Tivoli Enterprise Console server.

This section describes the new installation options that have been added to the instalnv script. These options can be used to configure event forwarding to the Tivoli Enterprise Console during the installation of the Tivoli NetView program. These options can be used only during a new installation.

Usage:
instalnv -k KIT [-d b/a/l] [-c "name1 name2 name3 ... name6"]
[-t serverName [-p port] [-w]] [-h]

Where:
-k KIT  Specifies the kit to install: SERVER, CLIENT, BOOKS. Note that CLIENT is
         not available on Linux.
-d b/a/l Specifies the discovery mode as follows:
   b  Backbone-only
   a  All networks
   l  Local subnet only

   This parameter is optional. The default is “Local Subnet Only”.
-c "name1 name2 name3 ... name6"
   Specifies a list of up to six community names used for network discovery.
   The community names must be separated by spaces and enclosed by
   quotes. This parameter is optional but if it is not specified, discovery might
   be limited if community names other than “public” are in use.
-t serverName
   The name of the Tivoli Enterprise Console server to which events are being
   forwarded. This parameter is optional.
-p port
   Specifies the port to be used for communication with the Tivoli Enterprise
   Console server. This parameter is optional. It is necessary to specify this
   parameter only if the port has been customized, otherwise the default (5529
   for a Windows® Tivoli Enterprise Console server, 0 for a UNIX Tivoli
   Enterprise Console server) value is used.
-w
   Indicates that the Tivoli Enterprise Console server specified with the -t
   option is a Microsoft® Windows machine. This option must be specified for
   a Windows Tivoli Enterprise Console server, otherwise the port will not be
   configured correctly.
-h
   Displays the usage statement.

This script does the following:
• Turns on event forwarding to the specified Tivoli Enterprise Console server.
• Sets the discovery mode as specified. The default is “Local Subnet Only”.
• Adds the specified list of Alternate Community Names (for example, -c "name1
  name2 name3") to the /usr/OV/conf/communityNames.conf file.

Using the nvits_config Script
The nvits_config script should be run on the Tivoli NetView server machine after a
new installation of Tivoli NetView for UNIX using the Tivoli Framework installation
method. This script does not need to be run if the instalnv script was used to install
Tivoli NetView. This script is provided to enable configuration of Tivoli NetView for
UNIX with a Tivoli Enterprise Console server.

/usr/OV/bin/nvits_config [-t serverName [-p port]]
[-c "name1 name2 name3 ... name6"] [-d b/a/l] [-h]

Where:
-t serverName
   The name of the Tivoli Enterprise Console server to which events are being forwarded. This parameter is optional.

-w
   Indicates that the Tivoli Enterprise Console server specified with the -t option is a Microsoft Windows machine. This option must be specified for a Windows Tivoli Enterprise Console server, otherwise the port will not be configured correctly.

-p port
   Specifies the port to be used for communication with the Tivoli Enterprise Console server. This parameter is optional. It is necessary to specify this parameter only if the port has been customized, otherwise the default (5529 for a Windows Tivoli Enterprise Console server, 0 for a UNIX Tivoli Enterprise Console server) is used.

-c "name1 name2 name3 ... name6"
   Specifies a list of up to six community names used for network discovery. The community names must be separated by spaces and enclosed by quotes. This parameter is optional, but if it is not specified, discovery might be limited if community names other than “public” are in use.

-d b/a/l
   Specifies the discovery mode as follows:
   b    Backbone-only
   a    All networks
   l    Local subnet only

   This parameter is optional. The default is Local Subnet Only.

-h
   Displays the usage statement.

This script does the following:
   - Turns on event forwarding to the specified Tivoli Enterprise Console server.
   - Sets the discovery mode as specified. The default is “Local Subnet Only”.

Note: This option clears the databases and restarts discovery. Do not use this script after an upgrade installation.
   - Adds the specified list of Alternate Community Names (for example, -c “name1 name2 name3”) to the /usr/OV/conf/communityNames.conf file.

Using the tecits_upgrade Script to Upgrade to New Event Class Structure

During an upgrade installation of Tivoli NetView 7.1.3, the old OV class structure and all user customizations for the Tivoli Enterprise Console are preserved.

Customers can continue to use their custom rules with the old class structure, if desired.

At any time after an upgrade installation (using either the Tivoli Framework or using the -u option of the non-Framework instalnv script), you can use the tecits_upgrade script to upgrade to the new TEC_ITS event class structure.

Usage:
/usr/OV/bin/tecits_upgrade [-s serverName] [-p port] [-w] [-h]

Where:
-s serverName
   The name of the Tivoli Enterprise Console server to which events are being
   forwarded. This parameter is not necessary unless you have never
   configured event forwarding to a Tivoli Enterprise Console server.

-p port
   Specifies the port to be used for communication with the Tivoli Enterprise
   Console server. This parameter is optional. It is necessary to specify this
   parameter only if the port has been customized, otherwise the default (5529
   for a Windows Tivoli Enterprise Console server, 0 for a UNIX Tivoli
   Enterprise Console server) is used. This parameter is not necessary unless
   you have never configured event forwarding to a Tivoli Enterprise Console
   server.

-w
   Indicates that the Tivoli Enterprise Console server specified with the -s
   option is a Microsoft Windows machine. This option must be specified for a
   Windows Tivoli Enterprise Console server, otherwise the port will not be
   configured correctly.

   This parameter is not necessary unless you have never configured event
   forwarding to a Tivoli Enterprise Console server.

-h
   Displays the usage statement.

The tecits_upgrade script does the following:
- Backs up the current trapd.conf file.
- Upgrades traps to the new TEC_ITS class structure including new slot mappings
  for some events.
- Updates the tecint.conf file (if it exists) to use the new TEC_ITS ruleset and class
  structure. If the tecint.conf file does not exist, and you have not specified the
  Tivoli Enterprise Console server information with the -s (and possibly -w and -p)
  options, you are prompted for the Tivoli Enterprise Console server name and
  related information.
- Sets the NVMAPGLOBALACK environment variable to 1. This is required for the
  Acknowledge function to work from the Tivoli Enterprise Console. It will change
  the default behavior of Acknowledge to use global-based mode. When
  global-based mode is set, the Acknowledged status is an object attribute. All
  NetView clients are notified when an object is acknowledged or unacknowledged
  immediately, regardless of which map is open or if the action is performed on a
  read-only map.
- Creates a new CiscoDevices SmartSet.
- Adds the Bandwidth Utilization for Routers and CPU Utilization for Cisco Devices
  SNMP data collections.

Tivoli Enterprise Console Server Compatibility
If you are forwarding events from Tivoli NetView to a version of the Tivoli Enterprise
Console that is earlier than version 3.7, you must set the Pre37Server flag to YES
in the /usr/OV/conf/tecint.conf file by adding the entry Pre37Server=YES. You must
stop and restart the nvserverd daemon after adding this flag. Use either the ovstop
and ovstart commands or Server Setup to stop and restart the daemon.

New Variable Bindings for NetView Traps
New variable bindings (varbinds) have been added to the following Tivoli NetView
traps:
Subnet Unreachable and Subnet Reachable Again events: Varbind 7 will contain the network address of the subnet and varbind 8 will contain the subnet mask.

All interface events: Varbind 7 will contain the IP address of the interface and varbind 8 will contain the interface name. The interface name is the short name assigned to an interface (for example, eth0 or hme0). This is used to uniquely identify the interface on a given node.

All node events: Varbind 7 is empty (unused) and varbind 8 contains a comma-separated list of the IP addresses of all the interfaces on the node.

All router events: Varbind 7 and 8 are unused.

All Layer 2 Status events: Varbind 7 is empty (unused), varbind 8 contains a comma-separated list of IP addresses for all interfaces on the node, varbind 9 contains the subnet IP address, and varbind 10 contains the subnet mask.

**New NetView Traps**

Three traps have been added for Layer 2 events. These are applicable for systems that have the IBM Tivoli Switch Analyzer installed. The Layer 2 traps are:

<table>
<thead>
<tr>
<th>Trap Name</th>
<th>Trap Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM_NVL2UP_EV</td>
<td>58916984</td>
<td>Layer 2 device is UP</td>
</tr>
<tr>
<td>IBM_NVL2DOWN_EV</td>
<td>58916985</td>
<td>Layer 2 device is DOWN</td>
</tr>
<tr>
<td>IBM_NVL2MARG_EV</td>
<td>58916986</td>
<td>Layer 2 device is MARGINAL</td>
</tr>
</tbody>
</table>

Eight CNAT-related traps are now installed with Tivoli NetView by default (formerly installed by the Tivoli NetView CNAT Extensions add-on product from the CNAT product CD).

<table>
<thead>
<tr>
<th>Trap Name</th>
<th>Trap Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CNATP_Started</td>
<td>77777770</td>
<td>Primary CNAT started</td>
</tr>
<tr>
<td>CNATP_Stopped</td>
<td>77777771</td>
<td>Primary CNAT stopped</td>
</tr>
<tr>
<td>CNATP_StartXlate</td>
<td>77777772</td>
<td>Primary CNAT started translating</td>
</tr>
<tr>
<td>CNATP_StopXlate</td>
<td>77777773</td>
<td>Primary CNAT stopped translating</td>
</tr>
<tr>
<td>CNATR_Started</td>
<td>77777774</td>
<td>Redundant CNAT started</td>
</tr>
<tr>
<td>CNATR_Stopped</td>
<td>77777775</td>
<td>Redundant CNAT stopped</td>
</tr>
<tr>
<td>CNATR_StartXlate</td>
<td>77777776</td>
<td>Redundant CNAT started translating</td>
</tr>
<tr>
<td>CNATR_StopXlate</td>
<td>77777777</td>
<td>Redundant CNAT stopped translating</td>
</tr>
</tbody>
</table>

**Web Console Security Enhancement**

**Passwords**

In Tivoli NetView Version 7.1.1, user IDs and passwords were stored in plain text in the NetViewRealm.properties file. Starting with version 7.1.2, passwords are not stored in plain text.
Web Console Enhancements

Submap Explorer
The Submap Explorer now displays connections and backbones in the Unreachable color when the containing network is Unreachable, and provides new telnet functionality. The Submap Explorer will also provide Layer 2 information if the optional Tivoli Switch Analyzer is installed on the server.

- **Layer 2 Information.** The System Configuration View now contains a Layer 2 Status column. This column displays information only when the Tivoli Switch Analyzer is installed on the Tivoli NetView server machine.
- **New Connection Color for Unreachable.** When displaying submaps that are parented by Unreachable networks, all connections and backbones are now drawn with the Unreachable color.
- **Telnet Command.** The telnet command is now available from the Object option in the main menu and from an object’s pop-up menu in the Tivoli NetView Web Console application. It is not available when the Web Console is run as an applet. Note that you can attempt to telnet to any node, but normally only UNIX nodes have a telnet service available.

Object Properties
Object Properties now provides Layer 2 status, new interface icons, new interface health information and new service status information. This version of Object Properties also enables you to quickly determine whether a node is in an Unreachable area (either by looking at the interface health information or by looking at the new icons that are displayed in the interface table).

- **Layer 2 Status.** The Other tab of the Object Properties window now displays the Layer 2 status (currently meaningful only for switches). This column is populated only when the Tivoli Switch Analyzer is installed on the Tivoli NetView server machine.
- **Interface Icons.** The interface table now shows an icon for each interface. The center of each interface icon is drawn in the Unreachable color when the status of an interface’s associated network is Unreachable.
- **Interface Health.** The Interface Health shows the percentage health for a node’s interfaces.
- **New Service Table.** The service table displays the last known services available for the target node and, if any of these services are currently down, the time of failure is also displayed. These services are the services that the nvsniffer program has been configured to discover and monitor.

Diagnostics: QuickTest and QuickTest Critical
Diagnostics QuickTest and QuickTest Critical now provide new Interface icons and results information to enable you to know whether the node being tested is within an Unreachable area.

- **Interface Icons.** The center of each interface icon is now drawn in the Unreachable color when the status of an interface’s associated network is Unreachable.
- **Results Column.** The Results column now contains text about networks with Unreachable status when a QuickTest or QuickTest Critical is performed for an interface associated with the network.

Web Console MIB Browser Enhancements
This section provides information about enhancements made to the Web Console MIB Browser.
**Viewing MIB Table Information:** To view the information for a particular row of the table (for a particular MIB instance), select a cell in the row. The View button is enabled. Click the View button to display the data.

**Graphing MIB Table Information:** To graph the MIB values for a particular column of a table (the values for all or some of the MIB instances), select a cell in the column. If the data for that column is graphable, the column is highlighted and the Graph button is enabled. Click the Graph button to graph the data.

**Filtering the MIB Browser Graph:** When you graph a MIB table column, the graph initially displays all the values for all the MIB instances (all the rows in the table) when you click Start. You can stop the graphing by selecting the Stop button. Once graphing stops, you can request to filter the graph by selecting the Filter button. You are presented with a list of the instances being graphed and can select which elements in the list to graph.

Like other lists in the Web Console, you can select elements from the list by clicking the left mouse key combined with using the <Shift> and <Ctrl> keys. After marking the desired instances as selected, click the Graph button to begin graphing for just the selected instances.

**New Timeout window:** A new window displays possible invalid community name or invalid hostname.

**Improved Performance of Timeouts and Wait Cursors:** The performance of timeouts and wait cursors has been improved.

**MIB Browser Refresh Processing with AIX® Server:** Due to timing issues and processing by underlying packages used by Tivoli NetView, using the MIB Browser's main refresh option on AIX might generate exceptions which are written in the netviewservlets.log file on the server. These exceptions do not interfere with any processing and can be ignored.

This mainly occurs when the refresh is done in the middle of walking the MIB tree. The same thing might be noticed if you close the MIB Browser while walking the MIB tree.

No sign of these exceptions will appear on the client side unless client-side debugging is turned on. With SNMP debug on, users might see HTTPProxyExceptions.

Examples of exceptions on the server side are:

```
2002-04-02 10:31:25,003 [SocketListener-1/1] ERROR
com.tivoli.netview.http.server.NetViewHttpServlet cchato@localhost.127.in-addr.arpa - Caught and rethrew exception in service
java.io.InterruptedIOException: Read timed out
java.io.InterruptedIOException: Read timed out

com.tivoli.netview.http.server.NetViewHttpServlet cchato@chatoaix.raleigh.tivoli.com - Caught and rethrew exception in service
java.io.IOException: Premature EOF
java.io.IOException: Premature EOF.
```

**Note:** When you are graphing dynamic tables (such as the ipForwardTable), if entries are removed while graphing is active, you will see warning messages in the log. Also, when you refresh dynamic tables, you might see different rows than before.
Router Fault Isolation (RFI) Enhancements

The Router Fault Isolation (RFI) function has been enhanced in three areas:

**Subnets with Routers - suppress all Node Down events.**
To reduce the false signals from a Node Down event for a device in an area with Unreachable status, Tivoli NetView does not generate Node Down events for any node in the area with Unreachable status. The first Node Down event that triggers an evaluation that results in declaring that the status of the subnet is Unreachable is also suppressed. However, the corresponding Interface Down events will continue to be generated until the status of the subnet is declared Unreachable. Afterwards, status polling to subnets with Unreachable status is suppressed by default.

**Subnets with some routers known**
In previous versions, the RFI implementation was such that if there was a back door to the subnet via a router Tivoli NetView had not discovered, then the status of the subnet could be declared Unreachable when it was not. This resulted in the subnet often toggling between Unreachable and Marginal status. The function has been changed in this release to reduce the chances of a reachable subnet being given Unreachable status.

**Subnets with no routers**
If Tivoli NetView is not managing any routers in a particular subnet, Tivoli NetView can now determine when that subnet is unreachable. It does this using a probabilistic algorithm, which determines when it is highly likely that the subnet is unreachable. Tivoli NetView automatically uses this algorithm for subnets where there are no managed routers. However, this algorithm only determines the reachability of the subnet. If it is unreachable, Node Down events are not generated.

**RFI Configuration**
There are three modes for RFI that can be configured:

1. **Disabled**: No attempt is made to determine reachability or root cause. Routers will generate node status events, instead of the root cause router status events.

2. **Router Fault Isolation Mode**: By dynamically evaluating the status of routers, Tivoli NetView will determine the reachability of subnets and the root cause of the partition or problem.

3. **Probabilistic Mode**: By dynamically evaluating the status of members of a subnet, Tivoli NetView determines whether it is more likely that the subnet itself is unreachable or whether the devices are down. This mode is disabled if the subnet contains less than a configured number of managed devices. This mode is automatically used for subnets with no managed routers if RFI Mode is active. You can fine-tune this algorithm using properties defined in the new configuration file, netmon.conf. See the /usr/OV/conf/netmon.conf file for more information.

To configure the RFI mode, use the Server Setup application. Select **Configure -> Set options for daemons -> Set options for topology, discovery and database daemons -> Set options for netmon daemon** and set the Router Fault Isolation Mode. Also available in Server Setup is the ability to treat ambiguous router interfaces that are not responding in unmanaged subnets as though their status is either Unreachable or Down. See the /usr/OV/doc/RouterFaultIsolation.htm file for information about using this option.
New netmon.conf Configuration File
This is a new configuration file for netmon that can be found in the /usr/OV/conf directory. Use this file instead of setting environment variables for the netmon daemon. The values in this file will override any environment variables that are set.

This file also contains configuration properties for the Probabilistic Reachability algorithm.

By default, all properties are commented out, except for the new reachability properties. To use a property, simply uncomment it and set the property as desired, and restart the netmon daemon.

Status Update Request
A new script enables you to prompt Tivoli NetView to update the status of a device. Tivoli NetView uses the appropriate status mode, SNMP or ICMP, to immediately poll all the interfaces on the device, and then update the map as necessary.

Applications residing on the Tivoli NetView management station can be configured to automatically invoke this script when they learn of a new status for a device. Using this script, applications can force Tivoli NetView to reflect the new status without waiting for the regular status poll cycle. Applications that do not reside on the Tivoli NetView management station can use the contents of this script to determine how to send an SNMP trap to Tivoli NetView to force a status poll without waiting for the regular status poll cycle.

Use the status update script as follows:
/usr/OV/service/nvstatusrequest.sh server target

where:
server The host name or IP address of the NetView server.
target The host name or IP address of the target system.

nvmaputil Command Line Interface (CLI) Utility
A new utility, nvmaputil, has been added to enable customers to do some limited management from the command line. This utility provides the ability to dynamically modify a NetView map without recycling the netviewd daemon and all its connected Web Console Submap Explorers. In addition, this utility enables visibility into which machines are in-scope for the Scopes defined for Web Server account access.

The nvmaputil utility solves the following type of problem for service providers: a misconfigured node from customer A could appear in customer B’s network. In other words, a misconfigured multi-homed node could report one or more IP addresses that actually belong in another customer’s network. When this situation occurs, it is disruptive to stop the netviewd daemon and bring up the native console to solve the problem, as operators would lose any current Submap Explorer connections when the netviewd daemon is stopped.

The specific management functions this utility addresses are as follows:
- Hide or unhide an interface and its associated nodes.
- Manage or unmanage an interface or a node.
- Delete all symbols attached to an object.

See the Appendix B: nvmaputil Utility for more information about the nvmaputil utility.
Cisco Devices SmartSet
A new CiscoDevices SmartSet is created by default during a new UNIX installation.

Updates to oid_to_type
The oid_to_type file has been updated with the most current OID information from device vendors.

SNMP Collections
Two new SNMP data collections are added during a new UNIX installation: Bandwidth Utilization for Routers (BandwidthUtilHdx) and CPU Utilization for Cisco Devices (avgBusy5). These collections are turned off by default. To activate these collections, select Tools -> Data Collections and Thresholds: SNMP from the native console.

Layer 2 Analysis Option Added to ovtopodump Utility
As a supplement to the Tivoli Switch Analyzer product, a new option (-X) has been added to the ovtopodump utility for assessing all Layer 2 devices stored in the topology database. Use this option to help determine why certain nodes are (or are not) considered to be Layer 2 nodes by the Tivoli Switch Analyzer product.

See the Tivoli Switch Analyzer Release Notes for more information.

Java Runtime Environments
The following platforms were upgraded to JRE 1.3.1:
- AIX
- The Solaris Operating Environment (hereinafter referred to as Solaris)
- Linux Intel
- Linux for zSeries™

Supported Platforms
- AIX: V4.3.3 (Maintenance Level 09)
- AIX: V5.1 (Maintenance Level 01)
- Solaris: V2.7, V2.8 (with all Sun-required patches)
- Linux Intel: RedHat Version 7.2 (2.4.7-10 kernel), SuSE Version 7.2 (2.4.4-4GB kernel)
- Linux for zSeries: SuSE Linux Enterprise Server 7 For S/390® and zSeries (SLES 7).

System Requirements
The system requirements for Tivoli NetView, Version 7.1.3 are the same as those described in the installation and system requirements sections of the Tivoli NetView Release Notes, Version 7.1 with the following exceptions:

Upgrade Restriction
Tivoli NetView, Version 5 is no longer supported. Users still running version 5 must upgrade to version 6 prior to upgrading to version 7.
AIX Software Prerequisites
The Tivoli NetView for UNIX, Version 7.1.3 program requires that AIX 4.3.3 systems have the Maintenance Level 4330-09 installed.
The Tivoli NetView for UNIX, Version 7.1.3 program requires that AIX 5.1 systems have the X11.compat package (X11R5) and Maintenance Level 5100-01 installed.

Linux Hardware Prerequisites
- 450 MHz Intel Pentium® or faster
- IBM S/390 Generation 5 or newer processor
- 512 MB of system memory
- 1 GB of swap space
- 500 MB of file system space for the Tivoli NetView program
- 500 MB of file system space for the network database
- Minimum video requirements
  - Configure the display to use 24 bit color.
  - Minimum resolution must be 1280x1024.

Linux Software Prerequisites
Tivoli NetView for Linux Version 7.1.3 runs on RedHat Version 7.2 or SuSE Linux for Intel Version 7.2, and SuSE Linux Enterprise Server 7 for S/390 and zSeries at kernel level 2.4.7 (referred to as SLES 7). The following packages must be installed:
- binutils
- inetd
- ucd-snmpd (RedHat rpm¹ is ucd-snmp, SuSE rpm is ucdsnmp) (Version 4.2.2 or higher)
- Xvfb (RedHat rpm is XFree86-Xvfb, SuSE rpm is xextra)
- pdksh (pdksh-5.2.14-8.i386.rpm or pdksh-5.2.14-248.s390.rpm must be installed from the RPM package provided on the version 7.1.3 installation CD)
- glibc-2.2.4–31 is required on SLES 7.
- Netscape Version 6 is required for correct operation of the Web Console Task Assistant running through an applet. The application version of the Task Assistant does not use Netscape.
- KDE Version 3 is required for Language Kit support.
- Konqueror is required on zSeries platforms.

Notes:
1. ¹ rpm = Red Hat Package Manager. See the man pages for more information about rpm.
2. Linux on Intel was tested on SuSE using KDE Version 2.1.2 and on Red Hat using the version of GNOME that is shipped with Red Hat Version 7.2.

Web Console System Requirements
The following hardware requirements apply to systems on which a Web Console is installed:
Table 3. Web Console System Hardware Requirements

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>450 MHz</td>
<td>1GHz</td>
</tr>
<tr>
<td>Memory</td>
<td>256 MB RAM</td>
<td>512 MB RAM</td>
</tr>
<tr>
<td>Hard disk space</td>
<td>35 MB ¹</td>
<td>35 MB ¹</td>
</tr>
</tbody>
</table>

Note: ¹ An additional 30 MB of temporary hard disk space is required during the installation.

If you install Netscape 7 with the Java 1.4 plug-in, use the Web Console thin client, because the Web Console applet requires the Java 1.3 plug-in. See the Tivoli NetView Release Notes, Version 7.1 for more information about the thin clients.

Netscape Version 6 is required for correct operation of the Web Console Task Assistant when the Web Console is accessed through an applet.

Installation Notes

The Tivoli NetView for UNIX, Version 7.1.3 program is a full image, and can either be a new installation, or an upgrade from previous versions of the Tivoli NetView for UNIX program (including Tivoli NetView for UNIX, Version 7.1). The installation instructions on all UNIX platforms for Tivoli NetView for UNIX, Version 7.1.3 are identical to those described in the section “Installing the NetView Program on UNIX” in the Tivoli NetView Release Notes, Version 7.1, with the exception of the Linux Intel platform.

If you are upgrading from a previous version of Tivoli NetView, be sure to remove any old backup directories, such as one that might have been created if you did an upgrade installation from version 6.0 to version 7.1. Backup directories are located in the /usr directory and are named OV.back.<version>.

If you upgrade a Server installation, IBM recommends that you perform the following procedure on all machines that previously ran the Web Console applet that was connected to an older version of the Web Server:

1. Display the Java Plug-in Control Panel as follows:
   a. On Windows, double-click the Java Plug-in 1.3.1 icon in the Windows Control Panel.
   b. On UNIX, run the JavaPluginControlPanel or ControlPanel executable in the bin or jre/bin directory under the directory where the 1.3.1 JRE is installed. On AIX, by default the JRE is installed in /usr/java131. On Linux and Solaris, find the directory named either IBMJava2-131 or j2re1.3.1.*.

2. From the Java Plug-in Control Panel, click the Cache tab.

3. Click the Clear JAR Cache button.

Memory Prerequisite Checking

The memory requirements of the Tivoli NetView program have increased: a minimum of 256 Megabytes of memory is required, however, 512 Megabytes of memory is recommended for efficient operation. The memory prerequisite checking function ensures that a sufficient amount of memory is available before installation begins. If more than 512 megabytes is available, no error message is displayed and the installation process continues. If less than 512 megabytes of memory is available, an error message is displayed as follows:
Table 4. Memory Prerequisite Checking

<table>
<thead>
<tr>
<th>Amount of Available Memory</th>
<th>Result</th>
<th>Message Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Less than 256 megabytes</td>
<td>The installation fails.</td>
<td>ERROR: There is not enough memory on the system to run Tivoli NetView. This system has 128 Megabytes of memory. A total of 256 Megabytes of memory is needed to run NetView. You need 128 more Megabytes of memory.</td>
</tr>
<tr>
<td>Between 256 megabytes and 512 megabytes</td>
<td>The installation proceeds.</td>
<td>WARNING: Although this system does satisfy the minimum required amount of memory to install NetView it does not meet the recommended amount of 512 Megabytes of memory needed for efficient operation of the NetView system</td>
</tr>
</tbody>
</table>

Linux Installation Notes

Use the following information in conjunction with the Linux installation procedure:

1. Prior to the installation of the Tivoli NetView for UNIX, Version 7.1.3 program, the /etc/hosts file must be configured to ensure correct topology discovery. The file must include both the fully qualified hostname and the shortname for the host on the line giving the host’s IP address, for example:

   123.45.67.89 myhost.local.domain.com myhost


3. Once the Tivoli NetView for UNIX, Version 7.1.3 program has been installed on Linux, edit the snmpd daemon configuration file to add the following passthrough statement:

   pass .1.3.6.1.4.1.2.6.4.6.1 /bin/sh /usr/OV/bin/mgragentd
   view system included .1

   This configures the SNMP daemon to forward a request for a MIB variable to the Tivoli NetView server.

4. Stop and restart the ovspmd daemon by entering the following commands:

   ovstop nvsecd
   /etc/init.d/netnmrc

5. Stop and restart SNMP by entering the following commands:

   /etc/init.d/snmpd stop
   /etc/init.d/snmpd start

Deprecated Function

The Submap Explorer option under the Tools menu has been removed from the Tivoli NetView for UNIX, Version 7.1.3 program. Use Tools → Launch Web Console instead of the old Submap Explorer.

Defects Fixed

This section lists defects that have been fixed as follows:

- Table 5 “Defects Fixed in Version 7.1.3”
- Table 6 “Defects Fixed in Version 7.1.2”
- Table 7 “Defects Fixed in Version 7.1.1”
<table>
<thead>
<tr>
<th>APAR Number</th>
<th>Abstract of Defects Fixed in Version 7.1.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>IY22822</td>
<td>Override severity in ruleset is ignored in further processing.</td>
</tr>
<tr>
<td>IY24918</td>
<td>Incorrect community name in MIB Browser panel in PDA window.</td>
</tr>
<tr>
<td>IY27172</td>
<td>NetView 6.0.3 trapd cores.</td>
</tr>
<tr>
<td>IY27638</td>
<td>IPmap cores if adding object with existing selection name.</td>
</tr>
<tr>
<td>IY28653</td>
<td>IP address truncated in OVOBJPRINT topm interface list.</td>
</tr>
<tr>
<td>IY29433</td>
<td>OVWDB hangs even though IY25986 E-fix installed.</td>
</tr>
<tr>
<td>IY29607</td>
<td>IPXWorkstation Filebase doesn't show on workstation symbol.</td>
</tr>
<tr>
<td>IY29797</td>
<td>MLM fails to display filter table on Solaris 2.8.</td>
</tr>
<tr>
<td>IY29858</td>
<td>TRUEREINIT doesn't work correctly for MLM on Solaris.</td>
</tr>
<tr>
<td>IY30054</td>
<td>Only 256 web clients allowed before all freeze.</td>
</tr>
<tr>
<td>IY30308</td>
<td>Momentary map freezes after upgrading to NetView V6.0.3.</td>
</tr>
<tr>
<td>IY30309</td>
<td>Seed file networks unmanaged if discovered by other mechanism.</td>
</tr>
<tr>
<td>IY30311</td>
<td>OVW cores after cut/paste followed by manage/unmanage.</td>
</tr>
<tr>
<td>IY30421</td>
<td>Reachable/Nonreachable network not always being handled correctly.</td>
</tr>
<tr>
<td>IY30683</td>
<td>NVDBFormatincorrectly matches objects with high object id.</td>
</tr>
<tr>
<td>IY30704</td>
<td>OVMapCount cores after applying Efix IY30308.</td>
</tr>
<tr>
<td>IY30856</td>
<td>Efix IY30704 correction.</td>
</tr>
<tr>
<td>IY30888</td>
<td>C_ARF2SRF is hanging while converting SMSIAAPPLICATIONS-14.</td>
</tr>
<tr>
<td>IY30894</td>
<td>Minor memory leaks in netmon eventually result in core.</td>
</tr>
<tr>
<td>IY30942</td>
<td>NetView 7.1.1 netmon limited to 256 Mb memory.</td>
</tr>
<tr>
<td>IY30944</td>
<td>OVMapCount -b cores after removing 25,000 objects from the map.</td>
</tr>
<tr>
<td>IY30945</td>
<td>Netmon requires recompile to bypass OS-imposed 256 Mb mem limit.</td>
</tr>
<tr>
<td>IY30946</td>
<td>OVTopoFix requires recompile to bypass OS-imposed 256 Mb mem limit.</td>
</tr>
<tr>
<td>IY31144</td>
<td>XNMLoadmib fails with ‘too many imports’ message.</td>
</tr>
<tr>
<td>IY31414</td>
<td>Web Client Event Browser doesn’t handle ruleset override severity.</td>
</tr>
<tr>
<td>IY31467</td>
<td>Better documentation on NVHotBackup needed.</td>
</tr>
<tr>
<td>IY31598</td>
<td>SelectionName not updated during initial discovery.</td>
</tr>
<tr>
<td>IY31760</td>
<td>Netmon memory leak in functionActionIfTable.</td>
</tr>
<tr>
<td>IY31770</td>
<td>OVMapCount producing incorrect output with excessive execution time.</td>
</tr>
<tr>
<td>IY31841</td>
<td>MLM core when executing a filter table “Matched Command”.</td>
</tr>
<tr>
<td>IY31843</td>
<td>Books fail using AIX-supplied NetScape with AIX 4.3.3 ML 08/09.</td>
</tr>
<tr>
<td>IY32067</td>
<td>OVTopoFix -C should exit gracefully when run again NVTurboDB.</td>
</tr>
<tr>
<td>IY32236</td>
<td>MLM 7.1.3 core on filter table on Solaris.</td>
</tr>
<tr>
<td>IY32258</td>
<td>OVW and NetViewD incorrectly update last synchronization time.</td>
</tr>
<tr>
<td>IY32274</td>
<td>ConvertNNM truncates topology interface lists.</td>
</tr>
<tr>
<td>IY32297</td>
<td>instainv script fails on managed node with wlocalhost defined.</td>
</tr>
<tr>
<td>IY32422</td>
<td>NetView UNIX 7.1.1 OIDS in seed file cause memory leak in ovwdb.</td>
</tr>
<tr>
<td>IY32527</td>
<td>Islpp script not working on LINUX installation.</td>
</tr>
<tr>
<td>IY32548</td>
<td>ovwls script output on linux installation.</td>
</tr>
</tbody>
</table>
### Table 5. Defects Fixed in Version 7.1.3 (continued)

<table>
<thead>
<tr>
<th>APAR Number</th>
<th>Abstract of Defects Fixed in Version 7.1.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>IY32566</td>
<td>IPMap may core (signal 4) if the map closed during initial synch.</td>
</tr>
<tr>
<td>IY32838</td>
<td>NetView control desk cannot be separated.</td>
</tr>
<tr>
<td>IY33059</td>
<td>Need method for checking total space requirements for update inst.</td>
</tr>
<tr>
<td>IY33118</td>
<td>Need Solaris hardware requirements for NetView 7.1.</td>
</tr>
<tr>
<td>IY33192</td>
<td>Document hostname restrictions NetView imposes on nodes.</td>
</tr>
<tr>
<td>IY33521</td>
<td>NetView UNIX 7.1.2 unable to set switch in netmon.conf file.</td>
</tr>
<tr>
<td>IY33630</td>
<td>Prereq checking uses wrong command to get hostname.</td>
</tr>
<tr>
<td>PJ28756</td>
<td>Missing documentation about acknowledging an object from the command line.</td>
</tr>
</tbody>
</table>

### Table 6. Defects Fixed in Version 7.1.2

<table>
<thead>
<tr>
<th>APAR Number</th>
<th>Abstract of Defects Fixed in Version 7.1.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>IY25741</td>
<td>OVSNMPCONFCLOSE() fails to release all file descriptors</td>
</tr>
<tr>
<td>IY27439</td>
<td>Check route node in ruleset shows incorrect setting</td>
</tr>
<tr>
<td>IY28079</td>
<td>IPMap trap input character described wrong in documentation</td>
</tr>
<tr>
<td>IY28144</td>
<td>NVSecD aborts with signal 4 and cores</td>
</tr>
<tr>
<td>IY28188</td>
<td>Memory management problems in NVCorrD leads to core</td>
</tr>
<tr>
<td>IY28360</td>
<td>Readcore hangs instead of returning useful error message</td>
</tr>
<tr>
<td>IY28494</td>
<td>Netviewd daemon pop-up boxes cannot be acknowledged</td>
</tr>
<tr>
<td>IY28526</td>
<td>SNMP configuration not updated by communityname.conf entry</td>
</tr>
<tr>
<td>IY28665</td>
<td>NVDBFormat SELECTRULE not searching entire list</td>
</tr>
<tr>
<td>IY28719</td>
<td>NVCorrD cores after ruleset change</td>
</tr>
<tr>
<td>IY28730</td>
<td>Segment status incorrect when interface is Admin Down</td>
</tr>
<tr>
<td>IY28800</td>
<td>Sysmon changes to correct CERT violations</td>
</tr>
<tr>
<td>IY28834</td>
<td>NVCorrD cores when user script overflows buffer</td>
</tr>
<tr>
<td>IY28841</td>
<td>Serversetup has bad default value for “SERVERPORT” field</td>
</tr>
<tr>
<td>IY28934</td>
<td>Rectrap cores when undefined trap received</td>
</tr>
<tr>
<td>IY29129</td>
<td>liblocal ICMP messages might be dropped due to contents</td>
</tr>
<tr>
<td>IY29166</td>
<td>Paging queue fills/cores without giving any messages</td>
</tr>
<tr>
<td>IY29171</td>
<td>Multiple netmon memory leaks</td>
</tr>
<tr>
<td>IY29203</td>
<td>Users Guide talks about “SUBMAP EXPLORER”</td>
</tr>
<tr>
<td>IY29356</td>
<td>No documentation for moving between location containers</td>
</tr>
<tr>
<td>IY29374</td>
<td>Performance issue after fix to man/unman node propagation</td>
</tr>
<tr>
<td>IY29392</td>
<td>Discovery fails if address is already as AD in object DB</td>
</tr>
<tr>
<td>PJ28175</td>
<td>NetmonNT core in function checkconninfo</td>
</tr>
<tr>
<td>PJ28510</td>
<td>Correction of Web Server security leak</td>
</tr>
</tbody>
</table>

---

Tivoli NetView for UNIX Version 7.1.3 Release Notes 23
Table 7. Defects Fixed in Version 7.1.1

<table>
<thead>
<tr>
<th>APAR Number</th>
<th>Abstract of Defects Fixed in Version 7.1.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>IY08054</td>
<td>xnmsnmpconf -update and -delete fail when using wildcards</td>
</tr>
<tr>
<td>IY18214</td>
<td>Need mechanism to clear invalid map timestamp</td>
</tr>
<tr>
<td>IY21738</td>
<td>Query SmartSet node doesn’t work for interface selection names</td>
</tr>
<tr>
<td>IY21803</td>
<td>NVColdD not deleting interface when its deleted from IPMAP</td>
</tr>
<tr>
<td>IY22700</td>
<td>Trapd cores using NVAddTrapDConf with large event name</td>
</tr>
<tr>
<td>IY23199</td>
<td>NVCold wrongly handles node with “Admin Down” interfaces</td>
</tr>
<tr>
<td>IY23387</td>
<td>SNMPCollect “Test” function window does not scroll</td>
</tr>
<tr>
<td>IY23828</td>
<td>MAC Addr of 0X000000000000 should be ignored for HSRP</td>
</tr>
<tr>
<td>IY23872</td>
<td>SNMP Status Polling problem during HSRP processing</td>
</tr>
<tr>
<td>IY24273</td>
<td>ISACKNOWLEDGED Field not reset to false in owdb</td>
</tr>
<tr>
<td>IY24405</td>
<td>Cut and Paste of location objects with contents not working</td>
</tr>
<tr>
<td>IY24614</td>
<td>NVDBFormat footer contains incorrect number of objects found</td>
</tr>
<tr>
<td>IY24675</td>
<td>Documentation incorrect for MLM Activation panel</td>
</tr>
<tr>
<td>IY24841</td>
<td>Can’t get object info when brackets in SELECTIONNAMES</td>
</tr>
<tr>
<td>IY24846</td>
<td>Older version of Release Notes shipped on NetView 7.1 CD</td>
</tr>
<tr>
<td>IY24858</td>
<td>Netview Maps hung waiting for data from socket</td>
</tr>
<tr>
<td>IY25294</td>
<td>SmartSet object count does not equal that of NVUtil -l</td>
</tr>
<tr>
<td>IY25342</td>
<td>Unmanaged network object does not have unmanaged IP status</td>
</tr>
<tr>
<td>IY25469</td>
<td>Map freezes when GLOBAL ACKNOWLEDGED enabled</td>
</tr>
<tr>
<td>IY25660</td>
<td>Memory leak found in OVWDB</td>
</tr>
<tr>
<td>IY25791</td>
<td>LANG variable not documented correctly in 7.1 Release Notes</td>
</tr>
<tr>
<td>IY25810</td>
<td>NetView 7.1 IPMAP cores when using location.conf</td>
</tr>
<tr>
<td>IY25819</td>
<td>SMConvert line wraps causing incorrect results downstream</td>
</tr>
<tr>
<td>IY25937</td>
<td>UNIX Polling file location incorrect in 7.1 Release Notes</td>
</tr>
<tr>
<td>IY25937</td>
<td>RFI incorrectly handling “Admin Down” interfaces</td>
</tr>
<tr>
<td>IY25971</td>
<td>NVCorrD cores with signal 11 due to memory leaks</td>
</tr>
<tr>
<td>IY25986</td>
<td>Map turns grey / freezes until dbxprof performed on OVWDB</td>
</tr>
<tr>
<td>IY26119</td>
<td>SNMP address being changed by NETMON</td>
</tr>
<tr>
<td>IY26301</td>
<td>COLLMAP fills nv6000.log with messages on socket problem</td>
</tr>
<tr>
<td>IY26404</td>
<td>Unneeded “address changed” traps during status polling</td>
</tr>
<tr>
<td>IY26405</td>
<td>Synchronization times between XXMAP and GTMD too slow</td>
</tr>
<tr>
<td>IY26423</td>
<td>Resolve database inconsistencies fails</td>
</tr>
<tr>
<td>IY26486</td>
<td>NVStat and OVStatus showing incorrect pids for Web daemons</td>
</tr>
<tr>
<td>IY26581</td>
<td>“Admin Down” Interfaces forcing frequent router checks</td>
</tr>
<tr>
<td>IY26725</td>
<td>Trapfiler at MLM doesn’t work with default trap destination</td>
</tr>
<tr>
<td>IY26983</td>
<td>Number of SRFS and ARFS limited per domain</td>
</tr>
<tr>
<td>IY27008</td>
<td>NVCOLTOSQL collecttime variable uses 2 digit year</td>
</tr>
<tr>
<td>IY27110</td>
<td>Selecting networks in serversetup for netmon not correct</td>
</tr>
<tr>
<td>IY27193</td>
<td>NVSniffer traps are inconsistent between NT and AIX</td>
</tr>
</tbody>
</table>
Table 7. Defects Fixed in Version 7.1.1 (continued)

<table>
<thead>
<tr>
<th>APAR Number</th>
<th>Abstract of Defects Fixed in Version 7.1.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>IY27343</td>
<td>OVActionD logging too verbose since trap security fix</td>
</tr>
<tr>
<td>IY27459</td>
<td>Modified netmon coring due to invalid object pointer</td>
</tr>
<tr>
<td>IY27554</td>
<td>ISACKNOWLEDGED not set to true for non-IP object</td>
</tr>
<tr>
<td>IY27692</td>
<td>Missing Java library error when running Java app scripts</td>
</tr>
<tr>
<td>IY27784</td>
<td>CiscoWorks 2000 install doc missing from netview 7.1 CD</td>
</tr>
<tr>
<td>IY28152</td>
<td>Missing argument descriptions in documentation for NVSniffer</td>
</tr>
<tr>
<td>IY28117</td>
<td>Large database causing long Web Client synchronization</td>
</tr>
<tr>
<td>IY28562</td>
<td>NetView fails CERT CA-2002-03 Test Cases</td>
</tr>
<tr>
<td>PJ28326</td>
<td>Syntax errors in netnmrc for NetView V7.1</td>
</tr>
</tbody>
</table>

Known Limitations

- Use of Tivoli NetView Web Console Security on UNIX systems requires root permissions. If you attempt to invoke Web Console Security as a non-root user on a UNIX system, you are denied access to Web Console Security and error messages are displayed.

- Tivoli NetView Version 7.1 mib2trap option of mibloader.sh does not recognize the following special comments that begin with --#:
  --#SUMMARY “Root cause failure: %s %s (%s)”
  --#ARGUMENTS { 2, 1, 0 }
  --#SEVERITY CRITICAL
  --#STATE NONOPERATIONAL
  --#SLOTMAP origin $V1
  --#SLOTMAP hostname $V2
  --#SLOTMAP protocol $V3

- Removing any one Tivoli NetView installation within a Tivoli Managed Region (TMR) also removes the Tivoli Framework registry entries within the Tivoli Framework database for all Tivoli NetView installations, and it appears as if there is no Tivoli NetView product installed on any node. A workaround for this problem is to simply reinstall the Tivoli NetView installations that are still installed. The Tivoli Framework will state that all components are already installed on that system, and when the Continue button is pressed, the registry entry is rebuilt.

- On the Solaris operating system, some Tivoli NetView man pages are not visible to the man command. Until the correct system patch can be determined, set the environment variable MANPATH to $MANPATH:/usr/share/man:/usr/OV/man.

- The Tivoli NetView Release Notes, Version 7.1 state that the install documentation for CiscoWorks 2000 is included in the /Adapters/Cisco directory of the Tivoli NetView Version 7.1 CD. This file was left off of the Tivoli NetView Version 7.1 CD; it can be found in the same directory on the Tivoli NetView for UNIX Version 7.1.3 CD.

- On Red Hat Linux, when running the Tivoli NetView for UNIX, Version 7.1.3 program, you cannot double-click a resource to open a view in the native console when running under the Sawfish Window Manager in the Gnome desktop. One alternative is to choose a different window manager such as TWM, or another desktop such as KDE.

  A second alternative is to change the Sawfish Window Manager defaults:
1. Start the Gnome control center.
2. Choose Sawfish Window Manager → Shortcuts.
3. From the Context drop-down list, select Window.
4. From the list, delete the three lines in which the command field is Raise Transients and pass through click.
5. Click OK.
6. Choose Sawfish Window Manager - Focus Behavior.
7. Select the Focus tab.
8. Select Raise windows when they are focused.
9. Click OK.

- On SuSE Linux, when running the Tivoli NetView for UNIX, Version 7.1.3 program, you cannot select multiple nodes in the native console when running under the Sawfish Window Manager in the Gnome desktop.

Use the following workaround:
1. Start the Gnome control center.
2. Choose Sawfish Window Manager → Shortcuts.
3. Change the Modifier key(s) used for default from Window Manager shortcuts from control to shift.
4. Click OK.

- The Global Acknowledge function provided by IPMAP is designed to work only with those objects in the map created and managed by IPMAP. Global Acknowledge for non-IP map objects created by the user or other OVw applications is not supported.

- If you are upgrading to the Tivoli NetView for UNIX, Version 7.1.3 program and have the Tivoli Business Systems Manager Adapter installed, contact your Tivoli representative for an update to the Tivoli Business Systems Manager Adapter.

- The nsvserverd.baroc and nsvserverd.rls files are not shipped with the Tivoli NetView for UNIX, Version 7.1.3 program. They are no longer necessary with the new enhanced integration between Tivoli NetView and Tivoli Enterprise Console. However, these files are not removed during an upgrade installation for existing customers who still use the old OV style event class structure.

- Tivoli NetView for UNIX servers must run on a system with a fixed TCP/IP address, not one that uses DHCP.

- We have seen problems resulting from the Linux routing cache containing stale incorrect entries. A symptom of a stale entry is when you can not Demandpoll a node that is Up, but you can access it through the MIB Browser.

Remedy: See the Linux documentation for instructions on deleting the default route entry and reading it to flush the stale entry. If the problem is that the route table and route cache do not display the same next hop entries for your destination of interest, then you might be experiencing ICMP redirect problems. Consult your operating system documentation for instructions on how to disable redirects if you do not want redirects to be performed on your Tivoli NetView workstation.

- For AIX systems with extremely large databases, special processing might be required prior to performing an upgrade. To determine whether this applies to your database, issue the following command: `/usr/OV/bin/ovtopofix -a`. If the command completes without an error, proceed with the upgrade. If the command fails, contact your IBM service representative.

- All HSRP routers must be managed to accurately display standby status.
The Linux SNMP agent for RedHat Versions 7.1 and 7.2, and SuSE Version 7.2 does not return the following interface table variables:
- `ifLastChange`
- `ifInNUcastPkts`
- `ifInDiscards`
- `ifInUnknownProtos`
- `ifOutNUcastPkts`

Note that the `ifInNUcastPkts` and `ifOutNUcastPkts` variables are required for the interfaces view that is displayed when you select **Monitor → Network → Interfaces**.

The installation of the Tivoli NetView program using the Tivoli Framework occasionally fails, with the Framework log files indicating that the failure was because the Tivoli NetView program was unable to rename its own log files from a `.error` suffix to a `.debug` suffix. This problem occurs because the Framework is placing the logs in a different area than the Tivoli NetView program expects. To resolve the problem, perform the following steps:
- Rename the directory `$DBDIR/tmp`.
- Link directory `/tmp` to directory `$DBDIR/tmp`.
- Perform the installation.
- Remove the link from the `/tmp` directory to the `$DBDIR/tmp` directory.
- Restore the original `$DBDIR/tmp` directory.

If you load or unload MIBs while the Web Console MIB browser is running, you must stop and restart the MIB browser to work with these MIBs.

When you use the Web Console MIB loader to load or unload MIBs, the MIB loader reloads all of the MIBs, and displays warning messages about all MIBs, not just the MIBs you last loaded or unloaded. If the commit was successful, ignore the messages.

Router Fault Isolation and Mid-Level Manager can function together and object status should remain accurate. However, in some cases both could poll the same nodes. This causes extra processing because routers are polled by both, and in some situations, this will cause extra network traffic.

If connectivity is temporarily lost between the Tivoli Enterprise Console server and the Tivoli NetView server, then you might notice a delay in receiving cached events in the Tivoli Enterprise Console when there are no new events being forwarded to the Tivoli Enterprise Console. This problem is most noticeable in environments that have periods of low event volume or activity. This situation is automatically corrected when the next event is forwarded to the Tivoli Enterprise Console server. To manually correct this problem, issue the `nvtecia -reload` command after the Tivoli Enterprise Console server is restarted, or stop and restart the `nvserverd` daemon.

---

**Documentation Changes**

- In the **Tivoli NetView Release Notes**, Version 7.1 the title “Polling Configuration File Changes” on page 33 should be changed to “Polling Configuration File Changes (Windows only)”, because these changes are not applicable to the Tivoli NetView for UNIX, Version 7.1 program.

- The **Tivoli NetView Release Notes**, Version 7.1 found in the PDF file in the top level directory of the Tivoli NetView for UNIX Version 7.1 CD are an earlier version of the release notes. The HTML file found in the top level directory of the Tivoli NetView Version 7.1 CD, the PDF and HTML versions found in the directory `/usr/OV/books/C` of the Tivoli NetView Version 7.1 installation, and the hardcopy version that are shipped as a part of Tivoli NetView for UNIX, Version 7.1 are the correct versions of the file.
• In the *Tivoli NetView Release Notes*, Version 7.1, the incorrect locale is given for AIX on page 97. The statement:

On an AIX system using Bourne or Korn shell, enter the following:

– export LANG=en_US
– export LC_MESSAGES=en_US

should be changed to:

On an AIX system using Bourne or Korn shell, enter the following:

– export LANG=En_US
– export LC_MESSAGES=En_US

• The *Tivoli NetView for UNIX Administrator’s Reference*, Version 7.1 does not list all of the flags for nvsniffer that are described in the Tivoli NetView nvsniffer man page. The following information should be included:

- **-d** Optionally, log to stdout the node and service combination to be tested. This is useful for diagnosing nodes that are slow to respond. Works best when used with one worker thread (-t 1) to avoid scrambled output.

- **-l logFile** Optionally, specify a log file to store the progress of nvsniffer. If the named log file already exists, the existing file is appended.

- **-m** Optionally, force the nvsniffer command to execute even if another instance of nvsniffer is already running. Use this option sparingly since each instance of nvsniffer can consume significant system resources.

- **-o** Optionally, test nodes that do not have an IP status of either Normal or Marginal. Nodes having an IP status of Critical are otherwise not tested.

- **-p physmem** Optionally specify the maximum amount of virtual memory (in megabytes) the Java Virtual Machine (JVM) running the nvsniffer application should occupy. The value specified for this option is not validated by nvsniffer; it is passed directly to the JVM that will execute the nvsniffer application. Tivoli recommends avoiding values higher than 64, especially if the -m option is used.

- **-r minutes** Optionally, re-run the current nvsniffer command in the specified number of minutes using the current set of switches. The valid range is 5 — 44640 minutes (up to 31 days maximum).

- **-s** Optionally, run nvsniffer in Status mode to test all known services for their current status. The node selection criteria for each entry is the {Service SmartSet} field. Running nvsniffer in Status mode is typically faster than using the default (Discover) mode, since only known services are tested.

- **-T timeout** Optionally, override the time to allow a test to complete (in seconds). The default is 10 seconds. For raw TCP port tests, some platforms do not allow such tests to be timed out; therefore if the time taken to perform raw port tests to a given node exceeds the timeout value, all remaining raw port tests to that node are skipped and a warning message is displayed. The maximum value is 120.

- **-v** Optionally, make nvsniffer display more verbose output regarding its progress.
The “Customizing Startup” section on Page 13 of the NetView for UNIX Configuration Guide, Version 7, shows the following statement:

To customize the startup process, modify the /usr/OV/bin/netnmrc.applsetup shell script, /usr/OV/bin/netnmrc.pre shell script, or /usr/OV/bin/netnmrc.aux shell script, rather than the netview and netnmrc shell scripts.

The reference to /usr/OV/bin/netnmrc.applsetup should be changed to /usr/OV/bin/applsetup.

The “Using Alternate Community Names” section of the Tivoli NetView for UNIX Configuration Guide, Version 7, begins at the bottom of page 55. The top of page 56 should be changed as follows:

The following section is incorrect:

Normally, netmon will use the community name from the SNMP configuration. If a name has not been configured for a device, it will use public, the default. If this fails, netmon will use the list in the communityNames.conf file, but only under the following circumstances...

It should be changed to:

Normally, netmon will use the community name from the SNMP configuration. If a name has not been configured for a device, it will use the global default. If this fails, netmon will use the list in the communityNames.conf file. The public community name is used only if it is configured for a specific node, configured as the global default, or is listed in the communityNames.conf file. Netmon will use the list in the communityNames.conf file only under the following circumstances...

The Tivoli NetView Release Notes, Version 7.1 (readme on page 67 and 68) and 7.1.1 (readmeupd on Page 6, number 5) should have included the following information about the potential security problem resolution:

Security Problem Description:

Several modifications have been added to this description, including an example of a sample script to remove escape characters, and is listed in its entirety here.

A change has been made to the ovactiond, nvcorrd, and actionsvr, daemons to eliminate a potential security problem where an unauthorized user with knowledge of Tivoli NetView trap customization, could gain root access to the Tivoli NetView system by sending a trap to the Tivoli NetView system from anywhere in the network.

This did not happen in the product as it is shipped, but could occur after trap customization was done by the Tivoli NetView administrator or by someone with root authority on the Tivoli NetView system.

The security problem can be created when a trap is customized to include a variable in the “Command for Automatic Action” field, in the “Action” field of an Action Node in a ruleset, or the “Command” field of an Inline Action Node in a ruleset. A trap could then be sent from any system using command substitution, rather than the intended variable, to execute unauthorized operating system commands on the Tivoli NetView system.

The UNIX daemons affected by this change are ovactiond, nvcorrd and actionsvr.

A list of the modified characters follows:

$`;&|@#%^<>\/{}-"!

When these characters are encountered, a message is entered into the appropriate daemon log file.

Problem Resolution

The ovactiond, nvcorrd and actionsvr daemons now filter out all non alphanumeric characters except for the minus sign (-) and the decimal point ( . ). All characters not falling into this set are replaced with an underscore ( _ ).
minus sign or decimal point is encountered it is escaped (for example, preceded by a backslash (\)) as a precaution. If any non-alphanumeric character is encountered, and filtering is not disabled, a message is entered into the appropriate log file (/usr/OV/log/nvcorrd.alog, /usr/OV/log/ovactiond.log, and /usr/OV/log/nvaction.alog).

The user can customize this behavior by using an environment variable called AdditionalLegalTrapCharacters. If the user sets this variable to disable, then no filtering is done. If the user sets this environment variable to a string containing non alphanumeric characters, then the filtering will allow those characters to also pass through the filter, but they are escaped. The best method for setting an environment variable for an ovspmd controlled daemon is to put the definition of the environment variable into the /usr/OV/bin/netnmrc.pre file, then stop and restart all the daemons (using netnmrc to restart).

Notes:

1. The contents of the environment variable AdditionalLegalTrapCharacters must be quoted, and some of the characters must be escaped to avoid being operated on by the shell or the system. The following assignment demonstrates a valid string for the AdditionalLegalTrapCharacters variable:

```
AdditionalLegalTrapCharacters=
! @ # $ % ^ & * () _ + | \ ` \ \ = - ] [ \ ' ; / . , ? > < \" : }
```

2. The following demonstrates a simple user script which can be used to remove the escape characters put into a string by this fix:

```
#!/bin/ksh
#
# The purpose of this script is to simulate a user script which
# sends a page after some processing to test nvcorrd and actionsvr
#
# We used to send the following:
#/usr/OV/bin/nvpage 1234567@skytel hi joe `date` $NVS $NVATTR_2 $NVATTR_3
#
# Now we will use sed to remove the escape characters
set -x
# fix up $NVATTR_2 to remove backslash "\"
host=`echo $NVATTR_2 | sed "s:\\\::g"`

echo $host
/usr/OV/bin/nvpage 1234567@skytel hi joe `date` $NVS $host $NVATTR_3
exit
```

The following section from the Tivoli NetView Release Notes, Version 6 was omitted from the Tivoli NetView Release Notes, Version 7.1:

**Configuring your Database for Routers with More than 20 Interfaces:**

If your network consists of any routers with more than 20 interfaces, then you will need to reconfigure the Tivoli NetView OVw object database. If you don’t perform this action, these routers might not be discovered correctly during the Tivoli NetView discovery process.

To reconfigure the Tivoli NetView OVw object database, use the /usr/OV/service/nvTurboDatabase tool at any point after creating the databases. When you use this tool, be aware of these restrictions:

- If you regenerate the OVw databases, you must run the tool again. It can be run at any time, regardless of whether the databases are empty.
- Do not run utilities that compact the databases, such as the commands:

```
ovtopofix -C
ovwdbdmap -c
```

To reconfigure the Tivoli NetView OVw object database, shut down all Tivoli NetView GUIs and then issue the following command from the command line:
For more information about this utility, see Appendix G “Database Enhancements in Tivoli NetView” in the Tivoli NetView for UNIX Configuration Guide. Note that this section now applies to AIX and Solaris.

- The man pages for the event command and for trapd.conf contain a typographical error. This error is that the source character used to represent the ipmap process (identified as “Ipmap sa”) is written as “+” instead of “I”. The plus “+” character is used in the man pages as the bullet character of a bulleted list, so there was a formatting problem when the man pages were extracted.

If one attempts to use the “+” in an event command, as in

```
event -h host1 -e MN_EV -s +
```

it will result in the error message:

```
invalid source +
```

The correct command would be

```
event -h host1 -e MN_EV -s I
```

There are no Tivoli NetView traps defined in trapd.conf with a source character of +, though the user can add traps or modify existing ones and use this value as the source. The Tivoli NetView traps from ipmap defined in trapd.conf all have the source character of I.

- The documentation (both the manuals and the location.conf file) should contain the following information that was omitted from the Tivoli NetView Release Notes, Version 7.1:

  Care must be taken when a user moves a symbol whose location is defined in the location.conf file. If such a symbol is cut and pasted to a new location, then duplicate symbols are displayed when IPMAP is restarted; one in the original location described in the location.conf file, and one in the new location defined by the cut and paste operation. If duplicate symbols are not desired, then the user must either remove the symbol from the location.conf file, or modify the location.conf file to reflect the symbol’s new location.

- Under “Software Requirements” in the “Installing the NetView Program on UNIX” section of Tivoli NetView Release Notes, Version 7.1, one of the “Additional Information” bullet items states:

  - If you want to use RIM with NetView Version 7.1 on Solaris, you must use Tivoli Management Framework 3.6.3 and not the 3.7 version of Tivoli Management Framework.

This restriction was removed in version 7.1.1 but was omitted from the version 7.1.1 release notes.

- In the Tivoli NetView Release Notes, Version 7.1, “Installing the Tivoli Integration Pack for Tivoli NetView (TIPN)” was discussed on page 113. The bulleted items in this section are correct, but references to the TIPN CD are obsolete. As described in the bullet item, the Tivoli Enterprise Console functionality is now incorporated into the base NetView package.

- The documentation (both the manuals and the location.conf file) should warn that a user should not cut from a manually-created location container and paste into a location container that was created by the location.conf file and vice-versa. Also, cutting and pasting between location containers created by the location.conf file is not recommended.
• In the *Tivoli NetView Release Notes*, Version 7.1 and the *Tivoli NetView Web Console User's Guide*, Version 7.1, all references to *default map* should be changed to *the read-write map*.

• The `-y` and `-Y` options of the netmon command are not in bold font in the man pages, so they are easy to overlook. The options are also described in the *Tivoli NetView for UNIX Administrator's Reference*.

• Some online help topics links do not work. Refer instead to the product documentation.

• The “Realtime graph” section of the *Web Console User's Guide* should state that you must click *Start* to begin graphing.

• The man page for the mib.coerce file should state that only MIB variables are *coerced*, not expressions. The following statement should be added to the Purpose section of the mib.coerce description in the *Tivoli NetView for UNIX Administrator's Guide*: Contains the configuration file for modifying the type of MIB data received from an agent for a MIB variable. Expressions are not coerced.

• The following information is not in the product documentation:

  To acknowledge an object from the command line, type:

  ```
  event -b openview -e event -a object ID
  ```

  Where:

  ```
  event
  ```
  Either ACK_EV (acknowledge event) or UNACK_EV (unacknowledge event)

  ```
  object ID
  ```
  The object ID of the object to be acknowledged in the OVW database.

  This event sets the status of the specified object to Acknowledged on all open maps where the object's status is CRITICAL or MARGINAL. It also sets the Acknowledged field to true in open Tivoli NetView maps. If no Tivoli NetView sessions are running in global-based mode, this field is not set. If NetView consoles running in global-based mode are started later, the object's status is displayed as acknowledged.

  For more information about this command, see the event man page.

• The online help panel `/usr/OV/online_help/C/lcgl1mst219.htm` should be changed as follows:

  8. Click Throttle Settings to specify the number of matching traps that are sent to the top-level manager. These values are used only if the Action field is set to throttle Traps. The Armed Command and Disarmed Command fields have a length limitation of 256 bytes.

• The *Tivoli NetView Release Notes*, Version 7.1, did not list the following information in the “Additional Solaris Information” section:

**Recommended Solaris Machine Types**

Contact your IBM service representative for information about the recommended Solaris machine type for the size of your network.

• The section “Forwarding Events to the Tivoli Enterprise Console” in Chapter 5 of the *Tivoli NetView for UNIX Installation and Configuration Guide*, Version 7.1, has been superseded by sections “Enhanced Tivoli Enterprise Console Integration” on page 9 and “Revised Tivoli Enterprise Console® Integration for Version 7.1.3” on page 8.
The nvserverd.rls and nvserverd.baroc files are no longer necessary, because they have been superseded by the netview.rls file that is included with Tivoli Enterprise Console, Version 3.8. The recommended NetView rule name is TEC_ITS.rs (to be used with the new netview.rls rule set).

Product Notes

- This product contains commands, scripts and tools that are not documented in manuals or online help which are intended for use by IBM service representatives, and are not supported for general customer use.

- If installing through the Tivoli Framework, install the Tivoli NetView Framework patch on all systems where Tivoli NetView is being installed. Both the Tivoli Framework Installation Patch and the Tivoli NetView Framework Patch must be installed on the TMR server and on the managed nodes where Tivoli NetView will reside.

- If the Tivoli NetView Web Server encounters out-of-memory errors, the following dialog is displayed on every Web Console that is attached to that Web Server:

  The Web Server is unstable.
  Results are unpredictable.
  Contact the NetView administrator.

In addition to these error messages, stack traces are displayed in the window that launched the Web Console. These stack traces normally contain a 503 error code was received (for example, “received bad HTTP response code ‘503’”).

If this occurs, the Tivoli NetView administrator should look at /usr/OV/www/logs/netviewservlets.log for any occurrences of the string “OutOfMemoryError”:

If such a string is found, the administrator should boost the memory setting that the Web Server uses. This can be done as follows:

1. Stop the Web Server using the command _ovstop webserver_.
2. Modify the file /usr/OV/www/bin/jetty.sh by changing the “-Xmx64m” string found on the JAVA_OPTIONS line to be something larger, like “-Xmx96m”. The “Xmx” setting is used to specify the maximum size of Java’s memory allocation pool. The Tivoli NetView program ships with the default set to “-Xmx64m” (64MB).
3. Start the Web Server using the command _ovstart webserver_.

- The Web Console should be upgraded to Version 7.1.3 on all systems. However, doing so will result in the loss of the list of hosts to which the Web Console has been previously connected that is displayed in the login dialog. This list can be retained by saving away the file lib/properties/DefaultHostAndPort.properties in the Web Console install directory before upgrading, and then copying it back afterwards, overwriting the newly-installed version.

- The following functionality has not been included in the Linux Intel platform release of Tivoli NetView for UNIX Version 7.1.3.
  - Agent Policy Manager (APM), C5eui, and MLM (Linux will have limited support for remote MLM configuration).
  - tralertd and spappld (the preferred method is to use MSM/IP and trap forwarding).
  - Cisco Adapter
  - Native Client Support (the Java Console is replacing the native client mechanism).
- XMP API support (for CMIP and CMOT applications)
- RIM Database Support (there is no support for TME® RIM).
- TME Installation (The Linux installation is Tivoli Framework independent).
- Tivoli Integration Pack for Tivoli NetView (TIPN supports integration with TME Framework components).
- Backup Manager.

- In general, devices that support the dot1dBridge MIB are supported by the Diagnostics Switch Management views.
- The MPLS Management views are supported on devices that support the MPLS LSR MIB.
- The nvTurboDatabase utility is designed to compress the object database. After many adds and deletes of objects, the database can get very fragmented. Using this utility can reduce the disk space used. This utility became available in NetView Version 6.0.3, but was omitted from the release notes. The nvTurboDatabase utility can be found in the /usr/OV/service directory and more information about it can be found under The “dbmcompress Utility” section of the NetView for UNIX Configuration Guide, Version 7.
- If you encounter any problems with the new telnet option in the Web console, verify that the TELNET_COMMAND path is correct in the /usr/OV/bin/nvwc.sh file.
- Starting with Tivoli NetView, Version 7.1.1, the Tivoli NetView CNAT components formerly installed as an add-on to Tivoli NetView from the Comprehensive Network Address Translator product distribution (product number 5698-NAT) are now part of the standard Tivoli NetView product.

The CNAT products (for example, the CNAT base product and the CNAT MibScanner) can be found on the separate IBM Tivoli Comprehensive Network Address Translator CD.

The nvCNAT components add the CNAT Operations menu options under the Tools menu. These menu options enable Tivoli NetView to discover all CNAT devices in your network and to automatically download all information necessary to identify all nodes in the network that Tivoli NetView has discovered which have IP addresses that have been translated by the CNAT devices. Node symbols (and the affected interface symbols) that have had their IP addresses translated by a CNAT system will have a “**” prefix and suffix added to the label name. For example, if node “systema.company.com” has an interface with an IP address that has been translated by a CNAT, the node’s symbol label is modified to “**systema.company.com**”, and the corresponding interface symbol label will also contain the added “**” prefix and suffix.

If you already have nvCNAT installed, it will automatically be migrated if you are upgrading to Tivoli NetView for UNIX, Version 7.1.3, and the nvCNAT uninstaller is automatically disabled to prevent accidental loss of nvCNAT capability.

For additional nvCNAT product information, see the Tivoli Comprehensive Network Address Translator Guide and Reference on the CNAT product CD.

- To send Tivoli NetView Web Console log messages to a file, edit one of the following files:
  - If running from /usr/OV/bin/nvwc.sh, edit this file:
    /usr/OV/www/webapps/netview/log4j.properties
  - If running from %NVWC_HOME%/bin/nvwc.sh, edit this file:
    %NVWC_HOME%/lib/log4j.properties
  - Edit log4j.properties by adding the following lines (after the existing ConsoleAppender):
log4j.appender.R=org.apache.log4j.RollingFileAppender

# Specify the file where you want the output to go.
log4j.appender.R.File=/usr/OV/www/logs/webconsole.log
log4j.appender.R.MaxFileSize=100KB

# Keep one backup file
log4j.appender.R.MaxBackupIndex=1
log4j.appender.R.layout=org.apache.log4j.PatternLayout
log4j.appender.R.layout.ConversionPattern=%d{ISO8601} [%t] %-5p %c %x - %m%n

– Modify the line:
log4j.rootCategory=INFO, A1
to be:
log4j.rootCategory=INFO, A1, R

**Note:** This adds the new file appender to the category.

To turn on debugging for a particular Tivoli NetView category or component, modify the line for that particular category (for example, snmp) as shown below.

Change:

log4j.category.com.tivoli.netview.snmp=INFO
to:

log4j.category.com.tivoli.netview.snmp=DEBUG

- Additional information about the hot backup function can be found in file /usr/OV/doc/HotBackup.htm.
- The Tivoli NetView for UNIX documentation cannot be displayed using the version of the Netscape browser that is shipped with AIX. To view this documentation, get the latest version of the browser from the Netscape website.
- Automatic space checking is incomplete when performing an upgrade installation. On an upgrade installation, space is required both for the backup directory (/usr/OV.back.vxrx, where x is the version and release you are upgrading from) and the new /usr/OV directory. The prerequisite checking script checks for space for each directory separately, but it does not check for enough space if the directories are installed in the same file system. This can cause the space checking to succeed when there is not enough space for both directories in the same file system.

As a workaround, if the /usr and /usr/OV directories are in the same file system, issue the following command to determine the additional space requirements:
/usr/OV/install/tools/nvp.vxrx test (where x is the version and release you are upgrading from). Add the additional requirements to the space requirements listed in [System Requirements](#) on page 18 for your operating system.

- System hostnames must conform to the ARPANET rules documented in RFC 1035 as follows:
  – The hostname must begin with a letter.
  – The hostname must end with either a letter or a number.
  – Hostname can contain only letters, numbers, and hyphens (-).

See RFC 1035 for more information.
Installing and Using the Tivoli NetView Language Kits

This section provides important information about installing and using the Tivoli NetView for UNIX, Version 7.1.3 Language Kit.

Note: Read this section thoroughly before installing or using the Language Kit.

Tivoli NetView for UNIX, Version 7.1.3 has new language kits. If you are upgrading from Tivoli NetView, Version 7.1.1 with the Language Kit, you must install the version 7.1.3 Language Kit.

Supported Languages:

AIX:
- Korean EUC
- Japanese EUC
- Japanese Shift JIS
- Simplified Chinese EUC

Solaris:
- Korean EUC
- Japanese EUC
- Simplified Chinese EUC

Linux:
- Korean EUC
- Japanese EUC

Installation Requirements

The following hardware and software prerequisites must be met before installing the Tivoli NetView Language Kits:

- Tivoli NetView for UNIX, Version 7.1.3 base English kit
- zLinux with SLES 7 and KDE Version 3
- RedHat 7.2 with KDE Version 3
- SuSE 7.2 with KDE Version 3
- 110 MB disk space on the /usr/OV partition per language (not including English). Note that a portion of this space is required by the installation process and is released afterwards.
- The baekmuk-ttf font package is required to run the Korean Web Console on SuSE 7.2.

Note: The Tivoli NetView for UNIX, Version 7.1.3 Language Kit was tested on RedHat 7.2 and SuSE 7.2 using KDE Version 3 and the version of GNOME that is part of the base distribution.

Installing the Tivoli NetView Language Kits

The following checklist provides the list of tasks you must complete to successfully install the Tivoli NetView Language Kits.

1. Set the LANG environment variable to the English locale.

   See “Setting the LANG and LC_MESSAGES Variables” in the Tivoli NetView Release Notes, Version 7.1 for information about how to set this environment.
variable. This variable must be set to the English locale when installing the
Tivoli NetView base English kit (client or server).

2. Install the Tivoli NetView for UNIX, Version 7.1.3 base English kit.

   **Note:** See the additional operating system restrictions in the previous section
      before you begin this task.

The Tivoli NetView base kit must be installed before the Language Kits. The
Language Kits are installed on top of the base kit. This kit is located on the
Tivoli NetView for UNIX, Version 7.1.3 CD that is included with the NetView
distribution.

For more information about how to install the base kit, see the *Tivoli NetView

3. If you are installing the Language Kit on a Tivoli NetView client, you must first
disconnect the client from the server. The Language Kit installation will fail if the
client is currently connected to a server. If you have connected the Tivoli
NetView client to a server, you must disconnect it before installing the Language
Kit on the client. Use the Client Setup application (clientsetup) to remove the
server from the client before installing the Language Kit (Configure ->
RemoveServer).

4. Stop all Tivoli NetView native consoles. If you have started the native console
on the server, or on any clients, you must shut them down before installing the
Language Kits.

5. Install the NetView Language Kits.

   In a non-Framework environment, from the command line, change to where the
CD is mounted and enter:

   ```
   ./installns -k kit -l locale
   ```

   where:

   **kit**  Is the type of installation required:
   - CLIENT (Not available on Linux.)
   - SERVER
   - BOOKS

   **locale**  Is the locale of the server:

   * kit locale
   - ko (Korean)
   - zh (Chinese)
   - ja_euc (Japanese EUC)
   - ja_sjis (Japanese Shift JIS)

   To install the Language Kit in a Tivoli Management Framework, see “Installing
the NetView Program in a Tivoli Management Framework Environment” in the

   Using the Tivoli Management Framework, choose the appropriate kit from the
Select Product to Install list:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Type of Installation</th>
<th>Kit Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX and</td>
<td>Simplified Chinese</td>
<td>Tivoli NetView Simplified Chinese Server Version</td>
</tr>
<tr>
<td>Solaris</td>
<td>Server</td>
<td>7.1.3</td>
</tr>
</tbody>
</table>

Tivoli NetView for UNIX Version 7.1.3 Release Notes 37
### Platform and Kit Names

<table>
<thead>
<tr>
<th>Platform</th>
<th>Type of Installation</th>
<th>Kit Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX and Solaris</td>
<td>Simplified Chinese Client</td>
<td>Tivoli NetView Simplified Chinese Client Version 7.1.3</td>
</tr>
<tr>
<td>AIX and Solaris</td>
<td>Korean Server</td>
<td>Tivoli NetView Korean Server Version 7.1.3</td>
</tr>
<tr>
<td>AIX and Solaris</td>
<td>Korean Client</td>
<td>Tivoli NetView Korean Client Version 7.1.3</td>
</tr>
<tr>
<td>AIX and Solaris</td>
<td>Japanese EUC Client</td>
<td>Tivoli NetView Japanese EUC Client Version 7.1.3</td>
</tr>
<tr>
<td>AIX only</td>
<td>Japanese Shift JIS Server</td>
<td>Tivoli NetView Japanese Shift JIS Server Version 7.1.3</td>
</tr>
<tr>
<td>AIX only</td>
<td>Japanese Shift JIS Client</td>
<td>Tivoli NetView Japanese Shift JIS Client Version 7.1.3</td>
</tr>
</tbody>
</table>

The online books are installed as a separate kit. The kit names are given in the table above. Before installing any of the language books kits, you must first install the Tivoli NetView Books 7.1.3 kit from the Tivoli NetView for UNIX, Version 7.1.3 CD and the base language kit for the operating system.

Note that although two Japanese locales are supported on AIX, there is just one set of Japanese books that is used for both these locales.

6. If you have installed Tivoli NetView Clients, configure Client/Server access. See “Configuring Client/Server Access” in the Tivoli NetView for UNIX Configuration Guide for information about how to configure Client/Server access.

**Note:** Client and server systems must be set to the same codeset. They must also be on the same platform (heterogeneous client/server between AIX and Solaris is not supported for the Language Kits).

### LANG and LC_ALL Environment Variable Settings

You must have the LANG and LC_ALL environment variables set to the appropriate locale in your current session when you start the Tivoli NetView native console or any other Tivoli NetView applications. The following table lists the supported LANG and LC_ALL environment variable settings for each codeset and platform:

<table>
<thead>
<tr>
<th>Codeset</th>
<th>AIX</th>
<th>Solaris</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Japanese EUC</td>
<td>ja_JP</td>
<td>ja</td>
<td>ja_JP</td>
</tr>
<tr>
<td>Japanese Shift JIS (AIX only)</td>
<td>Ja_JP</td>
<td>Not supported</td>
<td>Not supported</td>
</tr>
<tr>
<td>Korean EUC</td>
<td>ko_KR</td>
<td>ko</td>
<td>ko_KR</td>
</tr>
<tr>
<td>Simplified Chinese</td>
<td>zh_CN</td>
<td>zh</td>
<td>zh_CN</td>
</tr>
</tbody>
</table>
Note: Simplified Chinese (zh_CN) is available, but it is not fully supported.

Upgrading from a Previous Tivoli NetView Language Kit

If you upgrade from version 6.0 or version 7.1.1 with the Language Kit installed to version 7.1.3 with the Language Kit installed, you might have to update any customizations you made to the language files.

Migrating Security Files

The Tivoli NetView Security Registration Files are not migrated when upgrading from a previous version of Tivoli NetView. Any user modifications to the standard Tivoli NetView security registration files, located in the following directories, will not be migrated:

```
/usr/OV/security/$LANG/Domains/registration
/usr/OV/security/$LANG/Domains/SrAdmin
```

These files must be manually modified. The old versions of these files are located in your backup directory. The sample Oper group security registration files are no longer provided for the Language Kits. To create these files for the Oper group, use the nvsec_admin application to copy from the SrAdmin group and then modify the permissions of menus and applications to which you want to limit access.

If NetView Applications or Web Consoles Display in English

There are some restrictions in Tivoli NetView on the information that is translated. See "Translation Support" on page 41 for more information.

On Solaris, applications that are run on the Tivoli NetView server and are displayed on the client, such as the SNMP Configuration window, will display in English. See "Client/Server" on page 41 for more information about this problem.

If you experience other problems displaying Tivoli NetView applications in the desired language, follow these steps to solve the problem:

1. Stop all Tivoli NetView graphic applications on the server and any clients.
2. Check that the following environment variables are set correctly in your current session and for the root user on both the Tivoli NetView client and server:
   - **NLSPATH** - this variable must contain the following string before any language specific directories or cat files:
     
     ```
     /usr/lib/nls/msg/%L/%N:/usr/lib/nls/msg/%L/%N.cat
     ```
   - **XUSERFILESEARCHPATH** - this variable must contain the following string:
     
     ```
     ```
   - **LANG and LC_ALL** must be set to the correct codeset (as listed in the codeset table on the previous page). Use the locale command to display the current values.

The following system files can affect variable settings for all users:

- /etc/profile
- /usr/OV/bin/NVenvironment
- /etc/environment (AIX only)
- Files in the /etc/default directory (Solaris only)
The NLSPATH and XUSERFILESEARCHPATH variables can become very large if you have scripts running in your shell that are continuously appending to the existing path. If this occurs, these variables might become unusable by the shell, causing application text to be displayed in English. If you notice that either of these variables has an extremely long path list with duplicates, reset the variable to eliminate duplicate entries from the path list, and run scripts that append to these variables in your .profile or .login file instead of your .kshrc or .cshrc script.

3. Check that the system environment is set correctly on the Tivoli NetView client and server.
   On AIX, check that the cultural convention, language, and keyboard are set to the correct codeset using SMIT (Manage Language Environment...Change/Show Primary Language Environment).
   On Solaris, check that the LANG and LC_ALL environment variables are set to the correct codeset in the /etc/defaults/init file.

4. If you made any changes to system files in 2 on page 39 or 3, reboot the machine so these changes will take effect.
   - If step 1 on page 39 through step 4 did not solve the problem, then you might be inadvertently starting the Tivoli NetView daemons in the English locale by using the Tivoli Framework to stop and start the daemons, or you might be performing other administrative tasks that restart the daemons. The Server Setup application (serversetup) is the recommended method for restarting the daemons and other administrative tasks. You can also use SMIT on AIX. Use the `ovstatus nvsecd` command to determine whether the daemons are starting in English. If the last “message” field for the nvsecd daemon is displayed in English, they are being started in English.
   If the daemons are starting in English, use these steps to restart them with the correct locale:
   1. On AIX only, stop and restart the inetd daemon:
      ```
      stopsrc -s inetd
      startsrc -s inetd
      ```
   2. Stop and then restart the Tivoli NetView daemons:
      ```
      /usr/0V/bin/ovstop
      /usr/0V/bin/ovstop nvsecd
      /etc/netnmrc (AIX)
      /etc/init.d/netnmrc (Solaris and Linux)
      ```

**Installation Utility Scripts**

The following utility scripts are provided in the TOOLS directory on the Tivoli NetView language support CD:

<table>
<thead>
<tr>
<th>Script Name</th>
<th>Used to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>deinstal.ja_euc</td>
<td>Deinstall the NetView Japanese EUC client or server kit and books</td>
</tr>
<tr>
<td>deinstal.ja_sjis</td>
<td>Deinstall the NetView Japanese Shift JIS client or server kit and books (AIX only)</td>
</tr>
<tr>
<td>deinstal.ko</td>
<td>Deinstall the NetView Korean client or server kit and books</td>
</tr>
<tr>
<td>deinstal.zh</td>
<td>Deinstall the NetView Simplified Chinese client or server kit and books</td>
</tr>
</tbody>
</table>

**Language Kit Restrictions**

This section describes restrictions and known problems for the Tivoli NetView Language Kits.
**Client/Server**

Heterogeneous client/server between AIX and Solaris is not supported for the Language Kits.

Remote X display is not supported between AIX and Solaris because of font incompatibilities.

The Tivoli NetView client, server, and Web Console systems must be set to the same language and code set. Running the Tivoli NetView client and server in mixed languages is not supported. Corrupted characters are displayed in the maps and menus, and some of the functions in the Web Console will not work.

To display Tivoli NetView applications on a remote X display, the system on which the application is being displayed must also have the appropriate locale installed and set. Otherwise, corrupted characters are displayed in the maps and menus.

On Solaris, applications that are run on the Tivoli NetView server and are displayed on the client, such as the SNMP Configuration window, display in English. These applications are displayed correctly on the server for Solaris, but are not displayed correctly on both the client and server for AIX.

**Problem Starting Daemons from the Tivoli Desktop**

When you start the Tivoli NetView daemons from the Tivoli Desktop, they are started in the English locale. The workaround is to start the daemons using the Server Setup application (you can also use SMIT on AIX) or from the command line using the /etc/netnmrc (AIX) or /etc/init.d/netnmrc (Solaris and Linux) scripts with the correct locale set. The Server Setup application (or SMIT on AIX) is the recommended method of performing administrative tasks.

**Translation Support**

Programmer commands and functions, advanced administrative tasks, information primarily used by Tivoli Support for problem diagnosis, and SNMP data (which is by its nature English only) are not translated or enabled.

The following information is not translated:

- Base and Language Kit installations
- API definitions, man pages, command line utilities and program samples
- Database field names and enumerated values
- Map, submap and snapshot names
- SmartSet names and descriptions
- Symbol class/subclass names and status values
- MIB object names, descriptions, and enumerated values
- Trap names and descriptions
- Event information
- Event Source, Event Attributes, and Agent values
- Administrative support scripts used by Server Setup, Client Setup and SMIT are not fully translated
- NetView configuration menus in the Tivoli Framework
- Files in the /usr/OV/conf/$LANG directory, except for explore.conf
- Tracing and logging messages, with the exception of some messages in the /usr/OV/log/netview_<user>.log file
- Publications not listed in "Online Help and Books" on page 42
• Copyright screen and on-line help for the MLM Configuration Application
• The default Role names in Web Console Security
• There are no translated versions of the MLM

The following applications are not DBCS enabled:
• The Agency Policy Manager (APM) and SmartSet Editor are translated but are not DBCS enabled. SmartSet names, descriptions, and other information entered in these two applications must be English text.
• The Ruleset Editor is translated but not DBCS enabled. Event attributes and other field names must be entered in English.
• The Locate window supports multi-byte characters for exact matching but not when using regular expressions.
• The File -> View Report application, which is launched from the Event Display, is not DBCS enabled. You cannot view reports created using File -> Create Report that contain multi-byte characters.
• Map, submap, and snapshot names must be entered in English for all NetView windows. Multi-byte names are not supported.

Language Kit Notes

This section provides general product information for the Language Kits.

Language Kit Input Method on Linux

The default input method for the Japanese language kit on the Linux platform is kinput2. To use a different input method, edit all of the files in the /usr/OV/app-defaults/ja_JP directory and change the string kinput2 to the name of the input method that you want to use.

The Korean and Simplified Chinese language kits are not shipped with a default input method specified. Use the following procedure to specify an input method:
• Edit all of the files in the locale directory: either /usr/OV/app-defaults/zh_CN for simplified Chinese, or /usr/OV/app-defaults/ko_KR for Korean.
• Uncomment the line !*inputMethod: <input method> and replace <input method> with the input method that you want to use. For example, to use the xcin input method for simplified Chinese, specify:

  *inputMethod: xcin

Online Help and Books

You must install the Tivoli NetView Books 7.1.3 component and the specific language Tivoli NetView books component to use the online books.

The following publications are translated:
• Tivoli NetView for UNIX Configuration Guide
• Tivoli NetView Web Console User’s Guide
• Tivoli NetView for UNIX User’s Guide for Beginners
• Tivoli NetView for UNIX Administrator’s Guide
• Tivoli NetView for UNIX Administrator’s Reference

Note: KDE Version 3 is required on all Linux systems to use the online books.

All other books are in English only.
Web Browser Configuration for use with the NetView Web Console
If you are using the Netscape Communicator or Navigator to access the Tivoli NetView Web Console, configure the following settings in Netscape:

- Specify the font to use for the Unicode encoding, Edit -> Preferences...
  - Appearances... Fonts
- Select the UTF-8 character set, View -> Character Set -> Unicode (UTF-8)
- For more information about these settings, go to http://home.netscape.com/eng/intl/basics.html

If you are using Internet Explorer, follow these steps to configure the fonts:
- Select Tools -> Internet Options... Fonts, then select from Language script list, and choose a corresponding Web page font and Plain text font. If the page still doesn’t display correctly, select View -> Encoding -> Unicode (UTF-8).

Monitor Resolution
It is important to have a monitor with the appropriate resolution (as specified in the Tivoli NetView Release Notes, Version 7.1). The recommended dimensions are 1280 x 1024 pixels or higher. If you display NetView on a monitor with a lower resolution, the text and windows are very large, and some dialogs could become truncated.

Using NetView Security
You must have the correct locale set in your current session when invoking nvauth to log into security, or nvsec_admin to perform security administration tasks. Use the locale command to determine your current locale settings.

If your locale is not set to the appropriate language codeset, you will not be able to log into security using nvauth. The nvsec_admin application uses the current locale to determine which set of users, groups, and security registration files to modify.

Ping Tool Information in Wrong Panel with non-English AIX
On AIX, the Tivoli NetView ping tool might display regular command output in the panel reserved for error messages. This has been noticed especially for Korean and Chinese AIX locales and might be related to a defect in the behavior of the operating system-provided ping utility.

Chinese Character Display Problems under Solaris
Under Solaris 8, certain Chinese characters (for example, the double-byte dash character) cannot be displayed correctly in the Tivoli NetView Web Console. This applies to input as well as display fields. This problem has not been observed on other platforms using the same Web Console code and might be related to the Solaris JRE implementation.

Xcolormap Exhaustion in UNIX Environments
In all UNIX environments, Xcolormap exhaustion can cause display problems when running the Tivoli NetView application since NetView shares X colors with other X applications. As a result, menu labels under the mouse cursor might become illegible because of diminished contrast between highlight color and menu label text.

This problem is especially noticeable on AIX.

You can avoid this problem by making sure that Tivoli NetView is started prior to any other color-intensive X applications, such as Netscape Communicator.
Linux X Server Configuration
On Linux, it is important to configure the X server to use 24 bit color. Using less color might result in runtime problems, for example, fatal X errors.

Font Quality Issues with Web Console
The JREs for all platforms for which the Tivoli NetView application offers National Language Support use font settings which can result in the use of unattractive fonts in non-English environments.

To overcome this problem, IBM recommends the use of its World-Type font set. Contact your customer representative for information about how to obtain WorldType fonts and how to configure your JRE to use these fonts.

Tivoli Enterprise Console Language Kit Compatibility
If you are forwarding events to a version of the Tivoli Enterprise Console that is earlier than version 3.7, add the following required flags to the /usr/OV/conf/tecint.conf file:

• Set the Pre37Server flag to YES by adding the entry Pre37Server=YES.
• Set the Pre37ServerEncoding flag to the Tivoli encoding at the event server.

Stop and restart the nvserverd daemon as follows:
/usr/OV/bin/ovstop nvserverd
/usr/OV/bin/ovstart nvserverd

Appendix A: Event Mapping and New Class Structure

Table 8 lists the events that are forwarded by default. Table 9 on page 45 lists the event mapping and new class structure for events not listed in Table 8.

<table>
<thead>
<tr>
<th>ClassName</th>
<th>Replaces</th>
<th>Event</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEC_ITS_INTERFACE_ADDED</td>
<td>OVIfExistsDeleted</td>
<td>58785793 (IDEL_EV)</td>
<td>DELETED</td>
</tr>
<tr>
<td>Interface deleted</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_INTERFACE_MANAGE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interface unmanaged</td>
<td>OVIfUnmanaged</td>
<td>50790442 (UI_EV)</td>
<td>UNMANAGE</td>
</tr>
<tr>
<td>TEC_ITS_INTERFACE_STATUS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interface Up</td>
<td>OVIfDown</td>
<td>58916866 (IUP_EV)</td>
<td>UP</td>
</tr>
<tr>
<td>Interface Down</td>
<td>NEW</td>
<td>58916867 (IDWN_EV)</td>
<td>DOWN</td>
</tr>
<tr>
<td>Interface Admin Down</td>
<td>NEW</td>
<td>58916966 (IASD_EV)</td>
<td>AdminDown</td>
</tr>
<tr>
<td>Interface Unreachable</td>
<td></td>
<td>58916970 (IUNREACH_EV)</td>
<td>UNREACHABLE</td>
</tr>
<tr>
<td>TEC_ITS_ISDN_STATUS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ISDN Active</td>
<td>NEW</td>
<td>58916982 (IBUACTIVE_EV)</td>
<td>ACTIVE</td>
</tr>
<tr>
<td>ISDN Dormant</td>
<td></td>
<td>58916983 (IBUDORMANT_EV)</td>
<td>DORMANT</td>
</tr>
<tr>
<td>TEC_ITS_NODE_ADDED</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Node deleted</td>
<td>OV_NodeDeleted</td>
<td>58785795 (NDEL_EV)</td>
<td>DELETED</td>
</tr>
</tbody>
</table>
### Table 8. Events Forwarded by Default (continued)

<table>
<thead>
<tr>
<th>ClassName</th>
<th>Replaces</th>
<th>Event</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEC_ITS_NODE_MANAGE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Node unmanaged</td>
<td>OV_Unmanage_Node</td>
<td>50790419 (UN_EV)</td>
<td>UNMANAGE</td>
</tr>
<tr>
<td>TEC_ITS_NODE_STATUS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Node Up</td>
<td>OV_Node_Down</td>
<td>58916864 (NUP_EV)</td>
<td>UP</td>
</tr>
<tr>
<td>Node Down</td>
<td>OV_Node_Down</td>
<td>58916865 (NDWN_EV)</td>
<td>DOWN</td>
</tr>
<tr>
<td>Node Marginal</td>
<td>OV_Node_Marginal</td>
<td>50790400 (NM_EV)</td>
<td>MARGINAL</td>
</tr>
<tr>
<td>TEC_ITS_ROUTER_STATUS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Router Down</td>
<td>OV_Router_Status</td>
<td>58916971 (ROUTDOWN_EV)</td>
<td>DOWN</td>
</tr>
<tr>
<td>Router Unreachable</td>
<td></td>
<td>58916972 (ROUTUNREACH_EV)</td>
<td>UNREACHABLE</td>
</tr>
<tr>
<td>Router Up</td>
<td></td>
<td>58916973 (ROUTERUP_EV)</td>
<td>UP</td>
</tr>
<tr>
<td>Router Marginal</td>
<td></td>
<td>58916974 (ROUTMARG_EV)</td>
<td>MARGINAL</td>
</tr>
<tr>
<td>TEC_ITS_SNMPCOLLECT_THRESHOLD</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNMP Collect threshold exceeded</td>
<td>OV_DataCollectThresh</td>
<td>58720263 (DCOL_EV)</td>
<td>THRESHOLD</td>
</tr>
<tr>
<td>SNMP Collect re-arm threshold</td>
<td>OV_DataCollect_Rearm</td>
<td>58720264 (DCRA_EV)</td>
<td>REARMED</td>
</tr>
<tr>
<td>TEC_ITS_SUBNET_CONNECTIVITY</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subnet Unreachable</td>
<td>NV_Subnet_Reachability</td>
<td>58916968 (NETUNREACH_EV)</td>
<td>UNREACHABLE</td>
</tr>
<tr>
<td>Subnet Reachable again</td>
<td></td>
<td>58916969 (NETREACH_EV)</td>
<td>REACHABLE_AGAIN</td>
</tr>
<tr>
<td>TEC_ITS_L2_NODE_STATUS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Layer 2 device is UP</td>
<td>NEW</td>
<td>58916984 (IBM_NV2UP_EV)</td>
<td>UP</td>
</tr>
<tr>
<td>Layer 2 device is DOWN</td>
<td>NEW</td>
<td>58916985 (IBM_NV2DOWN_EV)</td>
<td>DOWN</td>
</tr>
<tr>
<td>Layer 2 device is MARGINAL</td>
<td>NEW</td>
<td>58916986 (IBM_NV2MARG_EV)</td>
<td>MARGINAL</td>
</tr>
</tbody>
</table>

**Note:** TEC_ITS_SA_STATUS events are also forwarded by default. See documentation for the optional Tivoli Switch Analyzer product for more information.

Table 9 lists the event mapping and new class structure for events that are not listed in Table 8 on page 44.

### Mappings between Events and New Class Structure

Table 9. Events and New Class Structure

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Replaces</th>
<th>Event</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEC_ITS_APPLICATION_ALERT</td>
<td>NV6K_Application_Alert</td>
<td>59047936</td>
<td></td>
</tr>
<tr>
<td>Class Name</td>
<td>Replaces</td>
<td>Event</td>
<td>Status</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------------------------</td>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td>TEC_ITS_APPLICATION_STATUS</td>
<td>NV6K_Application_Up_Event</td>
<td>5919056</td>
<td>UP</td>
</tr>
<tr>
<td></td>
<td>NV6K_Application_Down_Event</td>
<td>5917905</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS_ASM_MIB_DEF_FILE_FORMAT</td>
<td>NV6K_ASM_MIB_Def_File_Format</td>
<td>50790439</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_BAD_SUBNET_MASK</td>
<td>OV_Bad_Subnet_Mask</td>
<td>58982414</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CHANGE_IF_SEGMENT</td>
<td>OV_Chg_if_Segment</td>
<td>50790427</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CHANGE_NETMON_RETRY_COUNT</td>
<td>NV6K_Change_Netmon_Retry_Count</td>
<td>59179070</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CHANGE_POLLING_PERIOD</td>
<td>OV_Change_Polling_Period</td>
<td>50790411</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CMIS_EVENT</td>
<td>OV_CMIS_Event</td>
<td>58916870</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CONNECTION_ADDED</td>
<td>OV_Connection_Added</td>
<td>50790409</td>
<td>ADDED</td>
</tr>
<tr>
<td></td>
<td>OV_Connection_Deleted</td>
<td>50790410</td>
<td>DELETED</td>
</tr>
<tr>
<td>TEC_ITS_CPU_LOAD</td>
<td>NV6K_Cpu_Load</td>
<td>58720256</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_DISK_SPACE</td>
<td>NV6K_Disk_Space_Percentage_Used</td>
<td>58720257</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_ERROR</td>
<td>OV_Error</td>
<td>58851329</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_FATAL_ERROR</td>
<td>OV_Fatal_Error</td>
<td>58851330</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_FORCED_POLL</td>
<td>NV6K_Forced_Poll</td>
<td>50790412</td>
<td>START</td>
</tr>
<tr>
<td></td>
<td>NV6K_Cancel_Forced_Poll</td>
<td>50790413</td>
<td>CANCELLED</td>
</tr>
<tr>
<td>TEC_ITS_FORWARDING_TO_A_HOST</td>
<td>NV6K_Forwarding_To_A_Host</td>
<td>58785796</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NV6K_Hsrp_Added</td>
<td>58785797</td>
<td>ADDED</td>
</tr>
<tr>
<td>TEC_ITS_HSRP_ADDED</td>
<td>NV6K_Hsrp_Added</td>
<td>50790446</td>
<td></td>
</tr>
<tr>
<td>(UNIX Only)</td>
<td>NV6K_Hsrp_Deleted</td>
<td>50790447</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_CRC_ERROR</td>
<td>NV6K_Interface_Crc_Errors</td>
<td>58720260</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_DESC_CHANGED</td>
<td>OV_If_Desc_Chg</td>
<td>58982413</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_FLAGS_CHANGED</td>
<td>OV_If_Flags_Chg</td>
<td>50790446</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_PERCENT_DEFERRED</td>
<td>NV6K_Interface_Percent_Deferred</td>
<td>58720258</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_PERCENT_COLLISIONS</td>
<td>NV6K_Interface_Percent_Collisions</td>
<td>58720259</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_PERCENT_INPUT_ERRORS</td>
<td>NV6K_Interface_Percent_INPUT_ERRORS</td>
<td>58720261</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_PERCENT_OUTPUT_ERRORS</td>
<td>NV6K_Interface_Percent_Output_Errors</td>
<td>58720262</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_POSITION_CHANGED</td>
<td>NV6K_Interface_Position_Changed</td>
<td>50790447</td>
<td></td>
</tr>
<tr>
<td>(Windows Only)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_TYPE_CHANGED</td>
<td>OV_If_Type_Changed</td>
<td>58982412</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_INTERFACE_ADDED</td>
<td>OV_If_Added</td>
<td>58785792</td>
<td>ADDED</td>
</tr>
<tr>
<td>TEC_ITS_INTERFACE_MANAGE</td>
<td>OV_Manage_If</td>
<td>50790441</td>
<td>MANAGE</td>
</tr>
<tr>
<td>TEC_ITS_MAP_CHANGE</td>
<td>NV6K_Map_Change_Event</td>
<td>59113474</td>
<td></td>
</tr>
<tr>
<td>(Windows Only)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_ACTION</td>
<td>NV6K_Netmon_Action</td>
<td>50790426</td>
<td></td>
</tr>
<tr>
<td>(Windows Only)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_CHANGE_TRACE_FILE</td>
<td>NV6K_Netmon_Change_Trace_File</td>
<td>50790422</td>
<td></td>
</tr>
<tr>
<td>(Windows Only)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_CHANGE_TRACE_MASK</td>
<td>NV6K_Netmon_Change_Trace_Mask</td>
<td>50790423</td>
<td></td>
</tr>
<tr>
<td>(Windows Only)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_DUMP_NODE</td>
<td>NV6K_Netmon_Dump_Node</td>
<td>50790424</td>
<td></td>
</tr>
<tr>
<td>Class Name</td>
<td>Replaces</td>
<td>Event</td>
<td>Status</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>-----------------------------------------------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>TEC_ITS_NETMON_DUMP_INTERFACE</td>
<td>NV6K_Netmon_Dump_Interface</td>
<td>50790425</td>
<td></td>
</tr>
<tr>
<td>(Windows Only)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_ADDED</td>
<td>OV_Network_Added</td>
<td>50790407</td>
<td>ADDED</td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_ADDED</td>
<td>OV_Network_Deleted</td>
<td>50790408</td>
<td>DELETED</td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_FLAGS_CHANGED</td>
<td>OV_Network_Flg_Chg</td>
<td>50790443</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_MANAGE</td>
<td>OV_Manage_Network</td>
<td>50790416</td>
<td>MANAGE</td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_MANAGE</td>
<td>OV_Unmanage_Network</td>
<td>50790417</td>
<td>UNMANAGE</td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_STATUS</td>
<td>OV_Network_Normal</td>
<td>50790403</td>
<td>UP</td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_STATUS</td>
<td>OV_Network_Marginal</td>
<td>50790404</td>
<td>MARGINAL</td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_STATUS</td>
<td>OV_Network_Critical</td>
<td>58976869</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS_NODE_ADDED</td>
<td>OV_Node_Added</td>
<td>58785794</td>
<td>ADDED</td>
</tr>
<tr>
<td>TEC_ITS_NODE_FLAGS_CHANGED</td>
<td>OV_Node_Flags_Chg</td>
<td>50790445</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NODE_MANAGE</td>
<td>OV_Manage_Node</td>
<td>50790418</td>
<td>MANAGE</td>
</tr>
<tr>
<td>TEC_ITS_NO_SNMP_REPLY</td>
<td>OV_No_Snmp_Reply</td>
<td>58982409</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_OBJECT_ID_CHANGE</td>
<td>OV_Object_Id_Chg</td>
<td>58982403</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_PHYS_ADDR_CHANGED</td>
<td>OV_Phys_Addr_Chg</td>
<td>58982400</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_PHYS_ADDR_MISMATCH</td>
<td>OV_Phys_Addr_Mismatch</td>
<td>58982401</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_ADDED</td>
<td>OV_Segment_added</td>
<td>50790405</td>
<td>ADDED</td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_ADDED</td>
<td>OV_Segment_Deleted</td>
<td>50790406</td>
<td>DELETED</td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_FLAGS_CHANGED</td>
<td>OV_Segment_Flag_Chg</td>
<td>50790444</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_MANAGE</td>
<td>OV_Manage_Segment</td>
<td>50790420</td>
<td>MANAGE</td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_MANAGE</td>
<td>OV_Unmanage_Segment</td>
<td>50790421</td>
<td>UNMANAGE</td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_STATUS</td>
<td>OV_Segment_Marginal</td>
<td>50790401</td>
<td>UP</td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_STATUS</td>
<td>OV_Segment_Marginal</td>
<td>50790402</td>
<td>MARGINAL</td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_STATUS</td>
<td>OV_Segment_Critical</td>
<td>58916868</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS_SERVER_STATUS</td>
<td>NV6K_Up</td>
<td>58916964</td>
<td>UP</td>
</tr>
<tr>
<td>TEC_ITS_SERVER_STATUS</td>
<td>NV6K_Down</td>
<td>58916965</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS_SERVICE_POINT_APPL_CHANGED_MASK</td>
<td>NV6K_Service_Point_Appl_Changed_Mask</td>
<td>59179069</td>
<td></td>
</tr>
<tr>
<td>(Windows Only)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SERVICE_STATUS</td>
<td>NEW</td>
<td>58916976</td>
<td>UP</td>
</tr>
<tr>
<td>TEC_ITS_SERVICE_STATUS</td>
<td>NV_Service_Down</td>
<td>58916976</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS_SNMP_DATA_COL_FILE_FORMAT</td>
<td>NV6K_Sys_Data_Col_File_Format</td>
<td>50790440</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SNMP_STATUS_CHANGE</td>
<td>NV6K_Snp_Status_Change</td>
<td>58916871</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SUBNET_MASK_CHANGED</td>
<td>OV_Subnet_Mask_Chg</td>
<td>58982406</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SYS_DESCR_CHANGED</td>
<td>OV_Sys_Desc_Chng</td>
<td>58982410</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SYS_LOCATION_CHANGED</td>
<td>OV_Sys_Location_Chg</td>
<td>58982411</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SYS_NAME_CHANGED</td>
<td>OV_Sys_Name_Chg</td>
<td>58982405</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_TRALENT_CHANGE_TRACEMASK</td>
<td>NV6K_Tralert_Change_Tracemask_Event</td>
<td>59179068</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_TRAP_CONF_FORMAT_CHANGED</td>
<td>NV6K_TRAPD_CONF_Format_Changed</td>
<td>50790438</td>
<td></td>
</tr>
</tbody>
</table>
Table 9. Events and New Class Structure (continued)

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Replaces</th>
<th>Event</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEC_ITS_THRESHOLD_CHANGE</td>
<td>NV6K_Set_Threshold</td>
<td>50790414</td>
<td>SET</td>
</tr>
<tr>
<td></td>
<td>NV6K_Delete_Threshold</td>
<td>50790415</td>
<td>DELETE</td>
</tr>
<tr>
<td>TEC_ITS_UNDETERMINED_LINK_LEVEL_ADDR</td>
<td>NV6K_Undetermined_Link_Level_Addr</td>
<td>58982402</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_WARNING</td>
<td>NV6K_Warnings</td>
<td>50462720</td>
<td></td>
</tr>
</tbody>
</table>

Appendix B: nvmaputil Utility

Usage

`/usr/OV/bin/nvmaputil.sh`

```
[-h | --help] [-mapname map_name]
[--delete selection_name1 ... selection_nameN]
[--hide-symbol symbolID1 ... symbolIDN]
[--unhide-symbol symbolID1 ... symbolIDN]
[--hide-interface-and-node ip_address1 ... ip_addressN]
[--unhide-interface-and-node ip_address1 ... ip_addressN]
[--manage-node hostname_or_ip_address1 ... hostname_or_ip_addressN]
[--unmanage-node hostname_or_ip_address1 ... hostname_or_ip_addressN]
[--manage-interface ip_address1 ... ip_addressN]
[--unmanage-interface ip_address1 ... ip_addressN]
[--scopeinfo scope_info_filename]
[--dump-scopes | dump-scope scope_name]
[--dump-definitions <true_or_false>]
[--dump-nodes <true_or_false>]
[--dump-node-overlaps <true_or_false>]
[--dump-router-overlaps <true_or_false>]
[--logconfig log4j_config_file]
```

Where:

- `-h, --help` Display this help and exit.
- `--mapname` The currently opened read/write map to use.
- `--delete` The OVwDB selection names for which all associated symbols are to be deleted.
- `--hide-symbol` The mapdb symbol IDs to hide (use ovmapdump to obtain symbol IDs).
- `--unhide-symbol` The mapdb symbol IDs to unhide (use ovmapdump to obtain symbol IDs).
- `--hide-interface-and-node` One or more IP addresses, where each IP address entry results in hiding both an interface symbol and its associated segment-level node symbol and, if needed, its associated network-level node symbol as well (if it's an "isConnector" device).
- `--unhide-interface-and-node` One or more IP addresses, where each IP address entry results in unhiding both an interface symbol and its associated segment-level node symbol and, if needed, its associated network-level node symbol as well (if it's an "isConnector" device).
--manage-node  One or more hostnames or IP addresses, where each one corresponds to a node to be managed.
--unmanage-node One or more hostnames or IP addresses, where each one corresponds to a node to be unmanaged.
--manage-interface One or more IP addresses, where each one corresponds to an interface to be managed.
--unmanage-interface One or more IP addresses, where each one corresponds to an interface to be unmanaged.
--scopeinfo  The ScopeInfo.xml file to use, defaults to the file actively being used by the Web Server (/usr/OV/www/conf/ScopeInfo.xml).
--dump-scopes Dump scope information about all scopes and the in-scope OVwDB objects for these scopes.
--dump-scope Dump scope information for a particular scope and the in-scope OVwDB objects for this scope.
--dump-definitions If set to “true” the dumped scope information contains scope definitions (default is “true”).
--dump-nodes If set to “true” the dumped scope information shows in-scope nodes (default is “true”).
--dump-node-interfaces If set to “true” the dumped scope information shows the set of in-scope interfaces for each in-scope node [only useful if --dump-nodes is passed as “true”] (default is “true”).
--dump-interfaces If set to “true” the dumped scope information shows in-scope interfaces (default is “true”).
--dump-router-overlaps If set to “true” the dumped scope information shows in-scope router overlaps, where a router is found in more than one scope (default is “true”).
--dump-node-overlaps If set to “true” the dumped scope information shows in-scope node overlaps, where a non-routing node is found in more than one scope (default is “true”).
--logconfig The log4j configuration filename.

nvmaputil --hide-interface-and-node 10.42.242.21
Hide the interface symbol whose IP address is “10.42.242.21” and also hide the segment-level node symbol that this interface is attached to (for example, pluto.ma.ibm.tivoli.com). If the node attached to this interface was a connecting device, a node symbol found on a network-level submap might be set hidden as well (only if all interfaces that semantically belong to this network were now set hidden).

nvmaputil --delete sig.ma.ibm.tivoli.com
Delete the node sig.ma.ibm.tivoli.com.

nvmaputil --unmanage-node wopr.ma.ibm.tivoli.com cnatp.rtp.ibm.tivoli.com
nvmaputil --dump-scopes  Dumps out verbose scope information for currently
in-use scopes (based on the scopes currently
defined in /usr/OV/www/conf/ScopeInfo.xml).

nvmaputil --dump-scopes --scopeinfo /tmp/ScopeInfo.xml
Dumps out verbose scope information for the
scopes defined in /tmp/ScopeInfo.xml (useful if
trying to configure appropriate scopes without
stopping the Web Server to do so).

nvmaputil --dump-scope OurLan
Dumps out verbose scope information for the single
scope, OurLan (based on the scopes currently
defined in /usr/OV/www/conf/ScopeInfo.xml).

nvmaputil --dump-scopes --dump-definitions true --dump-nodes false
--dump-interfaces false --dump-outer-overlaps false --dump-node-overlaps
true
Dumps out all scope definitions and node overlaps
for the currently in-use scopes. Network service
providers might use a command like this to quickly
obtain the misconfigured IP addresses to use as
arguments in a subsequent call in which the
--hide-node-and-interface option is used.

Examples

The following nvmaputil examples involve two simple scopes, both being defined by
a single network. The WestfordLAN scope is composed of network 10.141.242, and
the LabLAN scope is composed of network 10.103.2. There are two multi-homed
nodes that are contained in both networks and, therefore, both scopes. These two
multi-homed nodes are ptasillo.ma.ibm.tivoli.com (containing interfaces
10.141.242.70 and 10.107.2.100) and wopr.ma.ibm.tivoli.com (containing interfaces

This example dumps the scope information for the WestfordLAN:

```
/usr/OV/bin>nvmaputil.sh --dump-scope WestfordLAN
Scope : WestfordLAN
Scope Definition
Resolved In Scope Nodes
Resolved In Scope Interfaces
Resolved In Scope Router Overlaps
Resolved In Scope Node Overlaps
 Overlapped Scope : LabLAN
```
This example dumps the scope information for the LabLAN:

```
/usr/OV/bin-nvmaputil.sh —dump-scope LabLAN
```

Scope : LabLAN
Scope Definition
Resolved In Scope Networks
Resolved In Scope Nodes
Hostname[1] : 10.107.2.140 (1047)
  Interface[1] : 10.107.2.139 (1064)
  Interface[1] : 10.107.2.155 (1054)
  Interface[1] : 10.107.2.3 (1040)
  Interface[1] : 10.107.2.1 (1038)
  Interface[2] : 10.107.2.5 (1050)
  Interface[1] : 10.107.2.100 (564)
  Interface[1] : 10.107.2.12 (566)
Resolved In Scope Interfaces
Interface[1] : 10.107.2.1 (1038)
Interface[2] : 10.107.2.3 (1040)
Interface[3] : 10.107.2.5 (1050)
Interface[5] : 10.107.2.100 (564)
Interface[8] : 10.107.2.155 (1054)
Resolved In Scope Router Overlaps
Resolved In Scope Node Overlaps
Overlapped Scope : WestfordLAN

The following example dumps out all scope definitions and node overlaps for the currently in-use scopes.

```
/usr/OV/bin-nvmaputil.sh —dump-scopes —dump-definitions true
—dump-nodes false —dump-interfaces false —dump-router-overlaps false
—dump-node-overlaps true
```

Scope : LabLAN
Scope Definition
Resolved In Scope Networks
Resolved In Scope Node Overlaps
Overlapped Scope : WestfordLAN
Scope: WestfordLAN
Scope Definition
Network[1]: 10.141.242 (517)
Resolved In Scope Networks
Network[1]: 10.141.242 (517) (Network Address: 10.141.242.0)
Resolved In Scope Node Overlaps
Overlapped Scope: LabLAN
NodeHostname[1]: ptasillo.ma.ibm.tivoli.com (522)
OverlappedInterface[1]: 10.107.2.100 (564)
NodeHostname[2]: wopr.ma.ibm.tivoli.com (528)
OverlappedInterface[1]: 10.107.2.12 (566)
Part Number: CT1HLIE
Printed in U.S.A.